
Mac  iPad  iPhone  Watch 50pages of 
tutorialso

ve
r

NEW 
iMAC PRO

macOS 
High 
Sierra

NEW
iPAD PRO

The ultra-high-
end killer Mac for 
professionals

Driving your Mac 
To increDible 
new heighTs

redesigned and 
enhanced for fun  

& fitness

brace yourself for 
apple’s new 64-bit, 
120hz powerhouse

Home
Pod
why apple’s new 
sMarT speaker will 
rock your house

INtRODuCINg  
tHE futuRE…

ios 11

fastest -ever iMacs & Macbooks revealed | iPhone survival guide | take perfect photos

• the biggest update ever
• over 80 new features

• why you should  
get excited!

watch
OS 4

2gb
of free 
downloads

issue 174





3

Facebook
iCreateMagazine

Twitter
@iCreateMagazine

Web
www.gadgetdaily.xyz

Email
icreate@futurenet.com

Welcome

Dave Clews
Recording engineer Dave is our resident Logic 
Pro X expert and this month he demonstrates 
how to resequence audio to transform loops 
and expand your EXS sampler library. 

Shaun McGill
Our tech expert has produced the ultimate iPhone 
summer survival guide this month. From booking 
holidays to getting the most out of the hottest 
music festivals, your iPhone has it covered.

George Cairns
George is an expert in iPhone photography, 
which is why he was tasked with putting 
together our masterclass on how to take 
stunning iPhone photos this summer.

Meet the experts

“Apple completely stunned us with its 
WWDC 2017 announcements”

 iCreate 174

There’s no denying it, Apple completely stunned us with 

its ‘Super Six’ WWDC 2017 unveiling of iOS 11, the new 

iPad Pro, macOS High Sierra, new Macs, watchOS 4 

and, of course, its house-shaking new smart speaker, 

the HomePod. By announcing exciting, feature-packed 

operating systems and new weapons of mass 

distraction (and ramping up the specs of all of its 

existing hardware across the board), Apple ensured that 

everyone present, as well as the watching world at 

large, became totally re-enthused in a company that has 

been short on punchy new tech over the past year. 

Needless to say, we bring you the full report on this 

ground breaking event in our extended news section.

Also this issue, we focus on the iPhone and how it 

can enhance your summer. From taking stunning 

photos, to helping you book holidays, get the most out 

of visits to foreign countries and even helping to 

heighten your experiences at the hottest music festivals 

and parties, the iPhone is your ultimate travelling 

companion, which we celebrate in two huge features!

Ryan Butt Editor
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Apple’s first foray into the smart home speaker market kicks off  
our extended WWDC 2017 coverage. Prepare to be excited…

HomePod to 
revolutionise music 

in the home?

WWDC 2017
Special 
Report



In a badly kept 
secret, Apple 
launched a smart 
home speaker 
called HomePod 

to tackle Amazon and Google 
head on after the wild success of 
their own rival smart speakers, at 
this year’s Worldwide Developer 
Conference. Apple is calling it a 
“breakthrough wireless speaker 
for the home” but what makes it 
special, or indeed smart?

Well, rather surprisingly, Apple 
has placed a big emphasis on 
the quality of audio. But when 
you look at the specifications, 
and importantly compared these 
with its main rivals, this could 
be HomePod’s biggest selling 
feature. Inside HomePod are 
seven beam-forming tweeters, 
which should provide a smooth 
and balanced sound output, as 
well as an upward facing woofer to 
keep the bass clean and deep. An 
A8 chip under the hood provides 
the brains behind the advanced 
audio innovations. HomePod 
has automatic room-sensing 
technology to always know where 
it is placed and provide a listening 
experience customised to that 
particular spot. 

Siri, Apple’s digital AI assistant, 
plays a huge role too. Built for 
voice, HomePod is fitted with six 
microphones, enabling use from 
across a large room even if loud 
music is playing. Anyone who has 
used Siri to control their music 
library before will be familiar with 
its powerful abilities – say “Play the 
best songs from 1996” or “Play 
my Summer playlist” and Siri will 
do exactly that. HomePod brings 
with it advanced search abilities, 
like asking “Who the drummer is in 
this song” or enabling an ‘Up Next’ 
playlist with other users in your 
home. The iconic Siri waveform 
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appears at the top of the speaker 
when activated, while there are 
integrated touch controls at all 
other times. HomePod is a natural 
partner to Apple Music, and will 
combine with the music streaming 
service to help provide a fully 
personalised music experience. It’s 
all ad free, too.  

Home help
As a home assistant, HomePod 
will let you send messages, get 
updates on news, sports and 
weather, or control smart home 
devices by simply asking Siri to 
turn on the lights, close the shades 
or activate a scene. When away 
from home, HomePod can act 
as a home hub, providing remote 
access and home automations 
through the Home app on iOS.

“Apple reinvented portable 
music with iPod and now 
HomePod will reinvent how we 
enjoy music wirelessly throughout 
our homes,” Philip Schiller, Apple’s 
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senior vice president of Worldwide 
Marketing said. “HomePod packs 
powerful speaker technology, Siri 
intelligence and wireless access 
to the entire Apple Music library 
into a beautiful speaker that is less 
than seven inches tall, can rock 
any room with distortion free music 
and be a helpful assistant around 
your home.”

Want to get your hands on 

HomePod right away? Well, 
you’re out of luck. Unfortunately, 
this is very much a preview 
announcement – HomePod 
won’t be available to order until 
December, and even then release 
is limited to the US, Australia and 
UK. The home speaker, which 
will come in space grey or silver 
casings, will be priced at $349, 
and UK and international prices 
will be announced later this year. 
Given the current weak pound, 
we can expect it to be £349. This 
prices it towards the top of the 
speaker market – of course, this 
is Apple, so we aren’t surprised at 
all – and we can’t wait to get our 
hands on one to test out all these 
features. When you do get yourself 
a HomePod, setup is as simple as 
holding an iPhone next to speaker 
and it’ll be ready to start playing 
music in seconds.

While the HomePod was the 
most intriguing of Apple’s big 
announcements at the WWDC 
2017 event, there was plenty more 
to get exciting about, including 
new Macs, new iPad Pros and, 
of course, the radically-advanced 
new operating systems to drive 
them – namely macOS High Sierra 
and iOS 11. Keep reading on for 
the full lowdown…

The HomePod has 
spacial awareness 
and can project its 
sound to fill any 
environment…
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Ramping up world’s most advanced mobile operating system

Get ready for iOS11

WWDC 2017
Special 
Report

 iPad Dock
A customizable iPad 
Dock can be used 
to store frequently 
used apps and can 
be accessed on any 
screen or in any app 
by swiping up.

 App Switcher
It is now easier to see 
what apps you are 
currently using and it 
even maintains your 
app spaces with your 
app pairings in Split 
View – impressive.

 New-look 
Control Centre
All of the features 
of the Control 
Centre have been 
incorporated back into 
a single, full-screen 
panel that utilizes 3D 
Touch for numerous 
extra features.

 Camera 
enhancements
Images in portrait 
mode support optical 
image stabilization on 
compatible devices 
and will also be able to 
take advantage of True 
Tone flash and HDR.



Apple announced 
the latest version 
of its mobile 
operating system 
at the WWDC 

2017 event and it boasts a 
significant set of enhancements for 
iPhone users, and many more for 
iPad users. But let’s start off with 
the fundamental enhancements 
that are applicable to both devices.

The Messages app, for example, 
now boasts a redesigned app 
drawer that makes it easier to 
discover new apps and stickers 
that you can use within the 
Messages app, including Apple 
Pay, which has been seamlessly 
integrated. Now, if someone 
messages you about you owing 
them money, the Apple Pay logo 
will appear in the predictive text 
bar and you will be able to pay 
them instantly by selecting it. Also, 
if you sign into any device with 
the same iCloud account, all of 
your messages and conversations 
will be synced, so if you delete a 
message on your iPhone, it will be 
deleted on your iPad too. What 
this also means – and this is a 
reoccurring theme throughout iOS 
11 – is that there will be less of an 
impact on your storage space as 
only the most recent messages will 
be stored on your device.  

Siri gets smarter
Apple’s assistant is used from over 
375 million Apple devices every 
month and currently operates 
in 21 different languages (more 
than any other assistant), but the 
enhancements come thick and 
fast in the form of a more natural 
and expressive voice, a better 
visual interface, multiple results for 
every query and new translation 
capabilities (currently, English to 
Chinese, French, German, Italian 
and Spanish are supported, but 
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iOS on iPad
The iPad enjoys some exclusive new features in iOS 11
As we mentioned earlier, iOS 11 offers even more for iPad 
owners, taking the tablet even closer to laptops in terms 
of functionality. For starters, a customizable Dock has 
been introduced that allows users to access their most 
frequently used apps from any screen and from within any 
app simply by swiping up from the bottom of the screen. 
The Dock also aids multitasking as you can open new 

apps straight into Slide Over and snap them into Split 
View to set them up as you want. A new App Switcher 
also lets you see all of the apps you are cureently using 
and switch between them. Perhaps the best iPad-only 
feature of iOS 11 though is Drag and Drop, which makes it 
easy to drag images, text, links and more from one app to 
another. The process is incredibly intuitive in practice.

many more languages will be 
introduced soon).

Siri’s powerful Machine Learning 
also now understands the 
context of your voice and tries to 
understand what you are likely to 
want to know or do next – such as 
providing an unprompted ‘time to 
leave’ notification based on your 
calendar and where you are. What 
Siri learns on one device is synced 
across all of your iOS and macOS 

devices and all information is kept 
strictly private between you two 
with end-to-end encryption.

Camera & Photos
Improvements to the Camera app 
mean that videos can now be 
captured in High Efficiency Video 
Coding (HEVC), which provides 
up to twice the compression. 
Likewise, the JPEG picture 
format has been replaced by 

“Siri now boasts 
new translation 
capabilities”
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WWDC 2017
Special 
Report

High Efficiency Image Format 
(HEIF), which also has twice the 
compression. This means that 
the videos you capture and the 
pictures you snap take up half 
as much space on your device 
– an aspect that is sure to prove 
popular with prolific picture-takers.

The enhancements to the 
Photos app are similarly subtle, 
but no less clever. Memories now 
utilises Machine Learning to better 
identify events, such as weddings, 
anniversaries and sporting events 
and your Memories movies 
can now by played in portrait 
orientation to utilise the full height 
of your iPhone. Live Photos, a 
feature that many simply forget 
to use, has also been improved 
to try and recapture peoples’ 
imagination. Now you can trim, 
select the key photo (the frame of 
the live photo displayed in Photos), 
mute them, loop them and bounce 
them back and forth.

Control Centre
Three become one in terms of 
Control Centre’s iOS 11 screen 
presence. Whereas in iOS 10 
there were separate screens for 
general utilities, music control and 
Home control, all of this has now 
been amalgamated into one neat 
panel in iOS 11. You can also 3D 
Touch on the various switches 
and buttons to access even more 
cool features. Your Lock screen 
and Notification Centre have also 
been merged so you can swipe 
down for Lock screen notifications, 
swipe up for all other notifications 
and then still swipe left for widgets 
and right for quick Camera access.

Maps and navigation
The Maps app has enjoyed 
some really exciting iOS 11 
improvements. How often have 
we travelled to shopping malls, 
concert halls and airports only to 
have them remain as big static 
blobs on the map with no further 
navigation possible? Not any 

more. Big buildings and precincts 
now feature detailed floor plans 
and search directories, so you 
can find out exactly what’s where. 
Also, in-app navigation now 
features local speed limits and lane 
guidance, so you know exactly 
where you need to be on the road 
for upcoming junctions, etc.

Perhaps the most worthwhile 
addition to navigation in general 
though is the ‘Do Not Disturb 
While Driving’ feature. Now your 
iPhone will sense when you 
are driving and cut all incoming 

messages. If you do receive any 
messages during transit then 
you won’t be distracted by them 
appearing on your screen and 
an automated message will be 
sent back to the original sender 
informing them that you are 
driving and that you will respond 
when you reach your destination. 
Really urgent messages can 
make it through by the original 
sender replying to the automated 
message with the word ‘urgent’. 
Also, the ‘Do Not Disturb While 
Driving’ feature can be overruled 
in the first place if you are, for 
example, the passenger and not 
the driver. It’s an important step in 
car safety that deserves applause.

Entertainment
A few neat tweaks have been 
made with Apple’s Home and 

Music apps. As you know, Home 
allows you to automate your home 
accessories from within the app, 
including locks, thermostats, 
cameras, shades and security. Well 
now Apple has added speakers to 
that list (were they really not there 
before?) so that you can access 
them with the AirPlay 2 protocol to 
build multi-room audio.

Meanwhile, in the Music app, 
you can now see exactly what 
your friends are listening to and, 
during get-togethers, access the 
master playlist, see what’s coming 
up next and then add your own 
music to the mix.

Redesigned App Store
To celebrate the ninth birthday 
of Apple’s online app emporium, 
the interface has undergone a 
massive refurbishment resulting in 

KEy FiGuRES
1 TRilliON…  

Photos taken per year  
through Apple devices

180 BilliON…  
Downloads from the App Store

500 MilliON…  
Weekly visitors to the App Store

50%… 
Amount of US stores  
accepting Apple Pay  

by the end of  
2017

“‘Do Not Disturb 
While Driving’ is 
an important step 
in car safety”
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Messages
This features a redesigned app 
drawer and all messages are 

synced to iCloud, with only the latest taking 
up space on your device.

Apple Pay
Send and receive money through 
the Messages app. Money 

received goes on an Apple Pay Cash 
Card that can be used for purchases or 
transferred to your bank.

Siri
Now features a more expressive 
voice, a more visual interface and 

can instantly translate for you. You can also 
use Siri with even more third-party apps.

Camera
Utilises High Efficiency Video 
Coding for videos and High 

Efficiency Image Format for pictures to half 
the space they take up on your device.

Photos
New features, such as trim, select 
key photo, loop and bounce 

breathe new live into Live Photos and 
Memories can now be viewed in the portrait 
orientation on your iPhone.

Control Centre
This has been completely 
redesigned so everything now 

sits back in a single, full-screen pane that 
utilizes 3D Touch to access deeper features.

Maps
Incorporates detailed floor 
plans into large buildings and 

complexes and also boasts local speed 
limits and lane guidance during navigation.

Do Not Disturb While Driving
A totally new feature that is 
activated automatically when 

motion is detected and severs all incoming 
alert distractions on your iPhone while you 
are driving. Great for road safety.

Home
Speakers have now been added 
to the Home accessories list, 

allowing you to build multi-room audio using 
the AirPlay 2 protocol.

Music
You can now see what your 
friends are currently listening to 

and contribute to – and even hijack – the 
master playlist at social gatherings.

App Store
Completely redesigned with a 
new tab system to find apps and 

games easier and more engaging app info 
pages to get shoppers excited. 

The Dock
New to iPad, fill the Dock with 
your favourite apps and access it 

on any screen by swiping up. You can then 
use it to seamlessly switch apps.

Multitasking
Access the Dock on iPad and 
you can pull an app out into Slide 

Over and snap them into Split View with the 
minimum amount of effort.

Drag and Drop
Drag images, text, etc, from one 
app into another. You can even 

multi-select and multi-drag items using 
multiple fingers. It’s amazing!

QuickType
On the iPad keyboard you can 
now flick on keys to access 

punctuation and numbers without switching 
layers. Enhanced productivity guaranteed.

Files
This new iPad app brings 
together all of the files on your 

iPad in one place and you can even 
incorporate files in third-party cloud storage 
apps placing everything within easy reach.

Markup
It is much easier to markup  
and share files. For example,  

you can take a screenshot, access it via  
a thumbnail, draw directly into it and share  
it in seconds.

Notes
Works closely with the Apple 
Pencil, also you can Spotlight 

search in hand-written notes and the app 
now contains a built-in document scanner 
that creates a PDF in seconds.

At-a-glance
New features of iOS 11, in a nutshell

a sleeker, more modern-looking 
store. Now, when iOS users visit 
they will be greeted by the ‘Today’ 
tab, which looks to harness the 
excitement that users felt when 
they first started shopping for 
new apps back in the day, and 
the giddy excitement felt when 
they discovered something new 
by showcasing the very latest 
apps and the stories about the 
developers who made them.

Another new tab, ‘Games’ 
is dedicated to the latest and 
greatest new mobile games 
and Apple has even managed 
to incorporate a new dedicated 
section for in-app purchases, 
making it easier for consumers to 
see when new levels, characters, 
etc, are available and then grab 
them instantly. The new look feels 
fresh, vibrant and exciting.

• iOS 11 will be 
available to download 
this coming Autumn 
for iPhone 5S and 
later, all iPad Air and 
iPad Pro models, 
iPad 5th generation, 
iPad mini 2 and later, 
and iPod touch 6th 
generation.



Two new insanely powerful additions to Apple’s family of tablets

The new iPad Pro

WWDC 2017
Special 
Report

Although the introduction of a 
new iPhone to Apple’s WWDC 
2017 Keynote was conspicuous 
by its absence, a new 10.5-inch 
iPad Pro and a redesigned 12.9-
inch iPad Pro certainly helped 
frenzy the assembled crowd 
into collective amnesia. The new 
10.5-inch model features a retina 
display that is 20 percent larger 
than that of the 9.7-inch iPad 
Pro, made possible by reducing 
the surrounding borders by 40 
percent – and it still only weighs 
one pound.
The new screen dimensions lend 
themselves perfectly to a full 
size on-screen keyboard or 
a full size Smart Keyboard 

(which now includes 
support for more than 30 
languages). Both new 
iPad models come 
with True Tone, wide 

colour gamut, ultraflow 
reflectivity, 600 nits brightness 

and HDR video. A new screen 
technology called ProMotion 
also provides a dramatically 

“The new iPads 
are 500 times 
faster than the 
original iPad”

• The 10.5-inch iPad Pro starts at $649 for the 64GB version and the 
12.9-inch iPad Pro starts at $799 for the 64GB version (256GB and 512GB 
versions are also available). Both models also come in silver, space gray, 
gold and rose gold and are available now.

enhanced display performance 
that doubles the refresh rate to 
120Hz – making it work much 
more accurately with the Apple 
Pencil (offering 20 millisecond 
latency). Interestingly though, the 
refresh rate adjusts automatically 
depending on what you are 
looking at (for example, a still 
image or a movie) and will scale 
down accordingly to conserve 
battery power. The new iPad 
Pro’s are powered by Apple’s 
new 64-bit A10X Fusion chip that 
provides a performance that is 
faster than most PC laptops and 
a six-core CPU and 12-core GPU 
deliver a CPU performance that 
is up to 30 percent faster and a 
graphics performance that is up 
to 40 percent faster than Apple’s 
own industry-leading A9X chip.

The Apple Pencil 
is more accurate 
when used with 
the new iPad Pro, 
with 20ms latency

14
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Get ready for the new and improved iMacs, MacBooks and MacBook Pros

Meet the new Macs
The fact that Apple’s iMac 
range was in desperate need 
of an update meant that a big 
announcement at the WWDC 
2017 event perhaps wasn’t much 
of a surprise, but an overhaul to 
its MacBook and MacBook Pro 
range most certainly was.

The 2017 iMacs will come in 
three models, 21.5-inch, 21.5-
inch 4K and 27-inch 5K, with 
plenty of internal enhancements 
across the range. All of the new 
iMacs will come equipped with 
seventh-generation Intel Core i5 
and i7 ‘Kaby Lake’ processors up 
to 4.2GHz, feature more powerful 
graphics, two Thunderbolt 3 
ports and faster storage options. 
For the first time, a Retina display 
is available in the 21.5-inch 4K 
and this high-end model (along 
with the 27-inch iMac) will 
also boast a Fusion Drive. The 
Retina displays produce one 
billion colours and 500 nits of 
brightness, so your workspace 
really becomes a showcase.

The new MacBooks up their 
numbers too to become 20 
percent faster, like the iMacs, 
thanks to seventh-generation 
Intel Core i5 and i7 ‘Kaby Lake’ 
processors. They will also feature 

iMac Pro
Apple’s new ultra high-end killer machine
Due for release in December, the new 
iMac Pro is the fastest, most powerful 
iMac ever, boasting a 27-inch 5K 
Display, next-generation Intel Xeon 
processors with up to 18-cores and 
Radon Pro Vega GPU 
with 11 Teraflops 
of single-precision 
compute power and 
22 Teraflops of half-
precision computation. 
The unit will also 
support up to 4TB of 
solid state storage 
and up to 128GB of 
ECC memory, a 10GB 

Ethernet port and four Thunderbolt 
3 ports for unrivalled speed and 
precision. Finished in Space Gray, the 
iMac Pro will eradicate the boundaries 
of imagination.

• The iMac 21.5-inch will start at $1,099, the iMac Retina 4K 21.5-inch will 
start at $1,299 and the iMac Retina 5K 27-inch will start at $1,799. The new 
MacBook and MacBook Pro 13-inch will both start at $1,299, the MacBook 
Pro 13-inch (with Touch Bar) will start at $1,799 and the MacBook Pro 
15-inch (with Touch Bar) will start at $2,399 – all are available now.

SSDs up to 50 percent faster and 
faster, smoother graphics. The 
fact that Apple has upgraded 
and enhanced seven of its most 
popular Macs is a clear signal 
of intent to constantly push new 
boundaries of power, speed and 
computing innovation.



WWDC 2017
Special 
Report

The update that will take your Mac to dizzy new heights

macOS High Sierra
Apple’s new Mac operating 
system, High Sierra is more about 
refinement over ‘wow’ factor. 
It promises to be packed with 
pleasing new enhancements, but 
perhaps lacks that show-stopping 
killer app or feature… for now.

Safari, for example, now features 
Autoplay Blocking to put you in 
control of whether or not you 
endure those annoying pop-up 
movie ads that seem to bombard 
your browser wherever you go. 
Intelligent tracking prevention also 
means that your surfing habits 
are entirely your own to know. 
The Mail app has a few welcome 
additions, such as Spotlight 
searching, split-screen composing 
and all of your mail will take up 35 
percent less disk space thanks 
to a fully optimised Apple File 
System (APFS) that also features 

native encryption, protects data 
from system crashes and speeds 
up simple operations, such as 
copying files.

High Sierra also adopts HEVC 
(H.265) support, which will enable 
higher-quality video streaming and 
playback of 4K video files and 
the next generation of Metal, that 
features a refined API to enable 
new graphics capabilities, speech 
recognition and natural language 
processing. The new OS is also 
built to support Virtual Reality 
software and devices, opening the 
door for users to enjoy incredible 
new VR experiences with 
peripherals such as the HTC Vive 
VR headset and apps like Final Cut 
Pro X, SteamVR, Epic Unreal 4 
Editor and Unity Editor.

With plenty more enhancements, 
including iCloud File Sharing, 

pinning in Notes, FaceTime Live 
Photos and expanded Spotlight 
searches (you can now enter flight 
numbers to view departure times), 
macOS High Sierra will redefine 
what you know and take your Mac 
experience to a whole new level. 

• macOS 10.13 High Sierra is 
currently available for developers 
with a public beta being made 
available at the end of June. The 
software will be available as a free 
update for everyone in Autumn.

macOS High 
Sierra lets 

developers 
create interactive 

VR experiences 
on Mac for the 

first time
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• watchOS 4 will be available as a free update this Autumn. GymKit, the 
technology that allows users to pair their watches with the equipment 
at their gym will also be implemented and rolled out with new gym 
equipment this Fall.

Bursting with functionality with an onus on fitness

watchOS 4
Even on a superficial level 
watchOS 4 delivers, because the 
new faces it brings to the fore are 
brilliant. The first one, powered by 
Siri, provides a constant rolodex 
of information that it thinks you 
will require as the day goes on. 
The second forms a kaleidoscopic 
effect from the colour schemes of 
your favourite photos to produce 
a truly trippy effect. And the 
third extends the Disney link by 
introducing fully animated Toy 
Story characters (Woody, Jessie 
and Buzz). We love them already.

Beyond the face-value fun, the 
main focus of watchOS 4 is on 
fitness, specifically the Activity 
app. This provides smarter fitness 
coaching to create monthly 
goals based on feats that you 
got close to accomplishing 

“Your watch’s 
enthusiasm 

for getting 
you active is 

relentless”

Facebook
iCreateMagazine

Twitter
@iCreateMagazine

Web
www.gadgetdaily.xyz

Email
icreate@futurenet.com

the previous month. It will then 
dangle incentives, in the form of 
achievements, to help you meet 
these goals. Your watch will also 
now be able to exchange data 
with the equipment in your 
gym via the Workout app and 
you can also perform multiple 
workouts within a single session. 
Even the flashlight in Control 
Centre can be used as a blinking 
safety light when you are out 
running at night – your watch’s 
enthusiasm for getting you active 
certainly is relentless.

Elsewhere, the Music app has 
been designed to support multiple 
playlists, the Dock scrolls vertically 
for easier navigation and the News 
app makes a welcome entrance 
into watchOS, beaming the latest 
breaking headlines to your wrist. 
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#Trending

Things we learned 
this month

Carpool Karaoke coming to 
Apple Music in August   Music

Carpool Karaoke, the hit 
segment created by British 
entertainer James Corden 
on his Late Late Show on 

CBS, is going to be aired as a full series 
exclusively on Apple Music from August 8, 
Apple has announced. 

Carpool Karaoke: The Series will feature 
many of the biggest names in music, 

television, film, sports and pop culture, 
all belting out their favourite songs on a 
road trip. Apple has announced some of 
the names we can expect to see taking 
the wheel in series one and they include 
LeBron James, Miley Cyrus, Will Smith, 
Alicia Keys and John Legend. The show 
will air every Tuesday for Apple Music 
subscribers in over 100 countries.   

Lauren Kern, Executive Editor of New York Magazine, has 
been appointed as the first ever Editor in Chief of Apple 
News in the biggest indication that Apple has massive 
plans for its iOS news aggregation app. Earlier this year, 

Apple executive Eddy Cue said the company wanted to “vet and 
make sure that the news providers” in Apple News are legitimate, in 
an effort to cut down on clickbait. Kern’s exact role is unknown but 
it is likely to be to do with improving the curation of news sources. 
News was launched in iOS 9 before undergoing a facelift in iOS 10.

Apple has big plans for  
its News app on iOS   News
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Ever thought you could do a better job of building 
Apple’s Maps app than the Cupertino giant itself? 
Well it’s been reported that Apple has been paying 
contracted freelancers to ensure the accuracy of points 

of interest and other types of crucial information. The report by 
iGenerate doesn’t specify how freelancers are selected, but they 

appear to be recruited through a third-
party subcontractor. We agree that 
the app needs to be better with 
contextual searches, and this 
seems like a good idea to us. 

Maps has come a long  
way since its bungled 
2012 introduction, but it 
does still lag behind  

Google Maps.  

The future of 
Bluetooth speakers 
is sounding great

This issue, iCreate was invited 
to attend the D&M European 
Dealer Conference in Malaga 
to experience the very latest 
audio ear-porn from Denon, 

Marantz, Polk and Definitive Technology. 
Highlights from the show included Denon’s 
new flagship 13-channel AV receiver (coming in 
2018), Polka’s Bluetooth Signa S1 Sound Bar 
(boasting incredible sound for only £199), and 
Polk’s MagniFi Mini Sound Bar that is small 
enough to position anywhere in the home but 
with a colossal audio kick to really blast out 
your Apple Music tunes via Bluetooth.

Also on display was Denon’s new Envaya 
range of portable Bluetooth speakers (due for 
release in October). These come in three sizes: 
Envaya Pocket (£89), Envaya Mini (£129) and 
Envaya (£169), feature a modern design with 
a touch of retro, are compatible with Siri voice 
recognition and sound brilliant when used 
around the home or out in wide open spaces.

“Highlights included 
Denon’s new flagship 
13-channel AV receiver”

Facebook
iCreateMagazine

Twitter
@iCreateMagazine

Web
www.gadgetdaily.xyz

Email
icreate@futurenet.com

Apple is using freelancers to 
improve its Maps service   Maps

Swift Playgrounds 
expands coding 

education to robots, 
drones and musical 

instruments   Swift Playgrounds

Swift Playgrounds, Apple’s 
educational coding app for 
iPad, now features a new 
way to learn to code using 

robots, drones and musical instruments. 
Apple is working with manufacturers to 
make it easy to connect to Bluetooth 
devices like Parrot drones and the 
LEGO MINDSTORMS Education EV3. 

“More than one million 
kids and adults are 
already using Swift 
Playgrounds to learn 
the fundamentals of 
coding with Swift,” 
says Craig Federighi, 
Apple’s senior vice 
president of Software 
Engineering. “Now they 
can instantly see the 
code they create and 
directly control their 
favourite robots, drones 
and instruments. It’s an 
incredibly exciting and 
powerful way to learn.”
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5
Although Apple products are certainly wondrous feats of engineering 
which assist, enthrall and entertain us on so many levels, they aren’t 
totally infallible and need a little help from us to keep operating at 
peak performance. This could involve quitting multiple apps to free up 
memory, condensing windows into one, and emptying caches to erase 
unwanted files. All of these tasks are quick and easy to perform and will 
undoubtedly enhance the performance of your Mac, iPhone or iPad.

minute projects
to try today

3

1 2

#Trending

Although having all of 
your most-used apps 
constantly open on 

your iPhone may save time 
when you want to access 
them, it can also affect the 
performance of your device. 
So why not give your iPhone 
a breather and shut some of 
them down?

1  Quickly close 
your open apps

1 double-
tap Home
Start off by 
double-tapping 
the Home 
button on your 
iPhone and all 
of the currently 
open apps will 
be displayed  
as a carousel 
that you can 
swipe through.

2 swipe 
upwards
To start closing 
open apps, 
simply swipe 
left or right to 
access the app 
that you wish to 
close and then 
swipe upwards 
over it to 
instantly close 
the app down.

3 single-
tap Home
Once you have 
closed all of the 
apps that you 
want, tap the 
Home button 
again and the 
screen will 
return to normal 
and your device 
may feel more 
responsive.

Clearing your iPad’s 
Safari app cache 
is an effective 

way to remove unwanted 
files from your device to 
aid performance. The only 
downside is that doing so 
will log you out of any sites 
that you are currently signed 
into, but hey-ho…

2  delete your 
safari cache

1 Go to settings
Start off by launching your iPad’s 
Settings app and then scroll down the 
left-hand column until you come to the 
Safari category and then tap on it.

2 clear history and data
In the Safari section, scroll down and 
you will see an option called ‘Clear 
History and Website Data’ near the 
bottom of the page – tap on this.

3 tap ‘clear’
After tapping the option a box will 
appear explaining the consequences of 
tapping this option. Go ahead and tap 
the ‘Clear’ option to complete the task.

Open windows within 
Finder are a surefire 
way to clutter up 

your desktop. But rather than 
close them all (which you can 
do by holding Alt and clicking 
the red ‘X’), there is a simple 
way to merge them all into 
one single, tabbed window for 
easy access. Here’s how…

3  merge your 
Finder windows

1 click ‘Window’
With numerous Finder windows open, 
click on the ‘Window’ menu bar item 
and then select the ‘Merge All Windows’ 
option from the menu.

2 Watch them merge
All of your open windows in Finder will 
now converge into one, with each set of 
contents accessible via tabs at the top 
of the window.

3 click the tabs
By clicking the tabs at the top of the 
window, you will be able to access the 
various windows without having them 
sprawled all over your desktop.





Summer brings you many photo 
opportunities. Longer days 
allow more time to photograph 
family activities. Summer 

holidays abroad present you with picturesque 
landscapes and beautiful buildings to capture 
on camera. Summer sunshine brings out more 
contrast and colour in your shots. 

This feature is designed to help you 
shoot better summer snaps that will 
make your subjects look their 
best. You’ll learn how to polish 
your summer themed shots to 
perfection using the Photos 
app, both on the move via 
your iPhone and from the 
comfort of your desktop Mac. 
We’ll show you how to organise 
your iPhone stored images and 
clips so that you can find files faster. 
To stop your summer-sourced shots 
gathering digital dust on your iPhone we’ll 
demonstrate ways to share them in a variety of 
formats so that they can be enjoyed by friends, 
family and the world in general on social 
networking sites such as Facebook.

But we’ll kick off by remembering the 
acronym GIGO – Garbage In, Garbage Out. 
If your summer photos are poorly shot in the 
first place then there’s only so much you can 
do to improve them using the Photos app. 
It’s better to get colour, tone and composition 
right to start with. On our feature’s first spread 
we’ll give you some shooting tips and suggest 
a range of accessories to help you get your 
summer shots looking their best in-camera, so 
that you can spend more time shooting and 
less time photo-fixing.

iPhone
Picture 
Perfect
Follow our expert advice 
on how to shoot the perfect 
snaps this summer

 Safe and stable
Hold your iPhone with both hands. 
A more stable camera is less likely 
to add shake-induced blur (which is 
impossible to fix using your iPhone’s 
post-production editing software).

 Shooting mode switching
Instead of tapping on a small label to 
change from shooting Photo to Video, 
simply swipe up or down anywhere in 
the screen (or left/right depending on 
the iPhone’s orientation) to switch to a 
new shooting mode.

 Snap a selfie
Tap here to swap the 
video feed from the front 
lens to the rear. You can 
then frame a selfie with 
ease. When shooting a 
selfie, tap the onscreen 
trigger rather than using 
the volume control 
buttons to avoid getting 
your hand in the frame.

 review your shots
After snapping a shot tap here 
to quickly review your picture for 
quality. If there’s a problem with 
focus or exposure it’s easier to 
re-shoot the image rather than 
spending time trying to fix it.
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Delayed 
trigger

To avoid camera shake-
induced blur caused by the 

tap of a finger or the click of a 
volume button, use the self-

timer to trigger a delayed 
shake-free shot.



When choosing a case or wallet for your iPhone, make sure that it doesn’t 
stop you accessing the volume controls or obscure the iPhone’s lenses.

Set up the perfect shot
Take time and care when shooting 
to avoid unnecessary editing

 Avoid fingers
Hold your iPhone with the Home button 
at the left so that the lens is at the 
bottom right, above your thumb. Your 
static thumb is less likely to obscure the 
lens than a flapping finger would if the 
lens was at the top left.

 Volume trigger
Instead of tapping the 
circular onscreen shutter 
icon you can use your 
finger to trigger the camera 
by pressing a volume 
control button. This 
physical button helps make 
your iPhone feel more like a 
conventional camera.

 flash off
When shooting in a location (such as a 
museum) where flash photography is 
forbidden, tap the Flash icon, then tap 
Off. This will keep you out of trouble from 
over-zealous security personnel.

 focus and exposure
Tap to focus on your subject (as 
your iPhone may not know what 
you’re interested in). Drag the 
sun icon up or down to fine-tune 
the exposure setting. 
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Levin Waterproof case
£10.99/$9.99
Thanks to this waterproof case you don’t need to 
stop shooting when you hit the beach – you can 
snap shots under the sea! Make sure that you 
buy the case from Levin Direct’s official Amazon 
page to avoid inferior knock-offs.

clas Ohlson 6700 Powerbank
£14.95/$19.95
Snapping, processing and uploading photos on 
your iPhone can use up your battery, so to avoid 
missing a photo opportunity pick up a charger. 
This one will recharge an iPhone 6 up to three 
times while out and about.

Veho Muvi X-Lapse tripod
£14.95/$17.95
This clever clockwork tripod 
rotates really slowly but 
very smoothly, enabling 
you to add pans to 
your iPhone’s time-
lapse sequences. 
It has an iPhone-
friendly mount and 
can be picked up 
for less than the 
recommended price if 
you shop around.

essential  
kit list  

Expand your range of  
summer shooting options  
with these accessories



tackle contrasting lighting scenarios
Capture highlight detail in camera so you can reveal missing shadows later

 fine-tune  
the exposure
Drag this slider’s sun icon 
up to open the aperture 
for a brighter exposure, 
or down to close the 
aperture. This helps you 
compromise between 
revealing more shadow 
detail without blowing out 
the brighter highlights.

 try the flash
If your subject is backlit by a bright light 
source, try turning on the flash manually. 
This could fill in the under-exposed 
foreground subject’s shadows and reveal 
more detail (if the subject is close enough).

 Live Photo
When this option is 
activated your iPhone 
will create a three-
second movie. To see 
and hear your moving 
Live Photo, hold down 
your finger on the 
image in Photos.

 Prioritise the highlights
If HDR doesn’t work, turn it off and 
tap to set the exposure to capture 
highlight detail in a specific area. It’s 
easier to restore missing detail to 
under-exposed shadows than it is to 
over-exposed highlights. use HDr setting

When shooting a high contrast scene try 
turning on the High Dynamic Range option (if 
it doesn’t appear automatically). This snaps a 
series of exposures and merges them together 
to reveal shadow and highlight detail.

 Zoom in
For a closer look at your subject (as if you 
were using a telephoto lens on a DSLR 
camera), pinch the screen to zoom in. 
Be aware that this digitally enlarges the 
subject so the image quality can drop.

How to use Burst mode
Capture the perfect shot when shooting action

When shooting a fast-moving subject such as a child, hold your 
finger down on the shutter icon. You’ll hear multiple shutter clicks and 
see a counter indicating the amount of shots that you’ve captured. In 

the Photos app you’ll see a single thumbnail with a Burst label. The amount of 
shots that you captured 
in the burst will appear 
in brackets. Click 
Select at the bottom of 
the screen and scroll 
through the individual 
images captured in the 
burst. Tick the images 
that you like and click 
Done. You can then 
keep your favourites 
and delete any of the 
unwanted frames from 
the burst. 

Shoot your own time-lapse
Condense long sequences into snappy clips

When shooting video an iPhone captures 30 frames (or images) per 
second and then plays them back at the same rate, ie normal speed. 
Your iPhone’s Time-lapse mode causes the camera to snap a series of 

shots at wider intervals. As there’s a pause between each captured shot the 
action occurs at a faster speed in a time-lapse video clip. Tap the Time-lapse 
button to start recording. When shooting time-lapse footage a tripod is 
essential; here the Veho X-Lapse tripod head is adding a pan to the footage.
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GoPro cameras provide a free Capture app to use your iPhone to adjust the 
Wi-Fi linked GoPro’s settings and trigger shots/video recordings remotely. 

Advanced techniques
Overcome summer shooting challenges 
with these specialist iPhone modes

Sunny summer locations offer a range of 
photogenic people and places to shoot. However, 
bright sunlight may cast harsh shadows, making 

it a challenge to capture detail in both the shadows and 
the highlights at the same time. Your iPhone’s HDR (High 
Dynamic range) mode helps you capture more detail in 
contrasting areas by shooting multiple images with different 
exposure settings and then merging them together as a 
single well-exposed shot. Another challenge you’ll face is to 
capture a landscape with the iPhone’s fixed lens. Using the 
Pano mode you can capture a wide-angle style image.

1 tricky lighting 
When faced with a contrasting 
landscape the iPhone may 
expose to capture detail in the 
darker areas. This can cause 
the sky to be over-exposed and 
lose detail in the brightest parts.

4 edit the shot
An HDR image will have a flat 
contrast, as it’s a compromise 
between capturing shadow and 
highlight detail. Tap the Edit 
button in Photos, and tweak the 
Light menu’s Contrast setting.

2 Set HDr mode
Tap on HDR. Set HDR mode 
to Auto or you can turn it on 
manually. As HDR mode shoots 
and merges multiple images it’s 
best for static subjects, so set it 
manually to avoid blur.

5 Wide angle view
To capture more of a scene, 
switch to Pano mode. Tap the 
record icon and pan slowly 
and smoothly to the right while 
keeping the arrowhead aligned 
with the horizontal line.

3 HDr shot
Snap your HDR shot. The 
merging process is automatic, 
so you’ll have a single shot with 
more detail in the shadows and 
highlights. It’ll feature an HDR 
label in the Photos app.

6 right to left
Hit record again when you’ve 
captured enough. Your wide 
angle image will appear in 
Photos as a panorama. To pan 
left while capturing a panorama 
simply tap the arrow.

Must-have 
accessories 
Expand your iPhone’s 
functions with these 
gadgets and apps

fabfocus
£3.99/$3.99
The iPhone 7 Plus enables you to 
add a background blur to your shots. 
This flattering effect can be added 
to portraits on any iPhone using 
FabFocus. It works automatically but 
you can fine-tune the blur effect to 
perfection with a few swipes.

Anker Selfie Stick
£8.99/$7.99
When shooting a selfie you might 
obscure the shot with a finger. The 
Anker selfie stick lets you trigger 
the shot remotely. It also gives you 
a wider frame of view rather than 
limiting you to arm’s length.

Manfrotto Pixi tripod 
with phone clamp
£34.95/$39.95
This tripod helps you shoot in a more 
disciplined and considered way, 
leading to improved composition. 
It also holds your video 
footage rock steady, 
resulting in more 
professional 
looking footage 
(rather than 
undisciplined 
amateur ‘hose-
pipe’ style 
material).

Before 
and after

When editing a shot in 
the Photos app it’s easy to 
‘overcook’ your processed 
picture’s colours and tones. 

Tap on the edited picture 
to compare it to  

the original.



edit your photographs
Overcome problems with colour, composition and tone by editing in Photos

 Adjustments
Tap this adjustment icon to 
summon tools that enable 
you to adjust exposure and 
colour more effectively. You 
can also create more effective 
black and white shots.

 One tap fix 
The Magic Wand icon 
causes Photos to analyse 
the shot’s colours and 
tones. In many cases 
this can boost contrast 
and create more vibrant 
colours instantly, but 
some shots will need 
manual adjustments. 

 improve composition
Click here to access your Photos 
app’s cropping tools. Drag corner 
handles to crop the shot to 
remove unwanted edge objects. 
Drag the angle dial to counteract 
tilted horizons.

 remove red-eye
If you use a flash in close 
proximity to your subject 
then the light may bounce 
off the blood vessels in 
their retina and make their 
pupils glow red. Tap this 
icon then tap on each 
problematic pupil to cure 
the red-eye.

 Want some more?
Click here to access alternative photo 
editors that you may have installed 
(such as PS Express). You can also 
summon Apple’s Markup tools and 
add labels and text to your photo.

 creative filters
Click here to access preview 
thumbnails containing creative 
colour and tone tweaking presets. 
Tap a thumbnail to apply its 
preset adjustment to the currently 
selected photograph.
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When shooting in the 
summer a common 
problem you may find is 

that your subject is back-lit by the 
sun. This can cause people to 
become silhouetted. If you brighten 
the shot overall you’ll blow out the 
correctly exposed highlights. Here’s 
how to selectively lighten under-
exposed shadows without over-
exposing the sky and create a more 
evenly-exposed image with detail 
where it matters. 

Lighten the shadows  Reveal detail in back-lit subjects

1 Access Light controls
In Photos, go to your problem picture and tap the Edit 
Photo icon at the top right. Click the Adjust icon. Tap the 
Light dropdown icon. Click the Light Settings icon.

2 Brighten the shadows
Click on Shadows. Drag the Shadows slider downwards 
to lighten the under-exposed shadows and reveal more 
detail without over-exposing the brighter background.

Perfect iPhone photos



If you’re unhappy with the effect produced by a Photos filter, go to Edit 
Photo and click the red Revert button.

3 colour correction 
As well as boosting colour saturation for more 
vibrant shots you can also use Photos to 
counteract colour casts. If a shot looks too cool 
(blue) you can warm it up with the Cast slider.

1 Become a cropper
Use the crop tool to remove unwanted objects 
and zoom in to your subject. You can also rotate 
the image to straighten tilted horizons and crop 
to different aspect ratios such as Square.

4 Black and White
Photos enables you to create a striking 
monochrome conversion of a summer scene. 
The B&W slider lightens or darkens objects 
based on their original colour. 

2 Boost contrast
In the Light menu you’ll find the Brilliance option. 
This clever tool lightens shadows, darkens 
highlights and reveals more delicate midtone 
detail, creating an image with more impact. 

common photo fixes
Discover more ways to fix and 
enhance your shots on the go

Most photographs will benefit from a bit 
of post-production processing before 
they look their best and are suitable for 

sharing. Fortunately your iPhone’s Photos app 
has all the tools you need to correct problems 
with colour, composition and tone in a few clicks. 
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Your iPhone’s Photos 
app enables you to 
change an image’s 

mood using creative filter 
effects. You can add effects as 
you snap a shot, but this gives 
you less choice than when 
adding a filter to an unfiltered 
shot in the editing stage.

1 Apply filters in-camera
Before taking a photo with your 
iPhone’s camera, tap the Filter button. 
Nine thumbnail preset previews will 
appear indicating a range of different 
looks. Tap the look that you prefer and 
snap the shot.

2 Apply presets after 
To apply a filter in Photos, tap the 
Edit Photos icon, then tap the Filters 
icon. Swipe through the filter preset 
previews to see how the shot might 
look. Tap a preset to apply the look to 
your photo. Click ‘Done’.

3 fine-tune filters
Free third-party app Camera+ has a 
larger collection of 35 filter effects. 
Unlike the filters in Photos, you can 
tap Advanced and use a slider to 
increase or decrease the strength of 
the applied filter.

Get 
the look

To access a larger 
collection of filter presets, 

use the free PS Express app. 
With an Adobe ID you can 
download even more filters 

in the Premium Looks 
section.

Have fun 
with filters
Get creative in a few taps



28

Marvellous 
monochrome
Create arty looking prints that stand 
out from the colour crowd
In the summer people have more time to shoot and share 
their holiday snaps. One way to draw attention to your 
own images amongst thousands of competing shots is 
to convert them to black and white. Creating an effective 
black and white shot is an art. To help certain objects stand 
out in contrast you’ll need to ensure that you have some 
strong black shadows and white highlights in the processed 
picture. Thanks to the Photos app you can also lighten or 
darken specific objects based on their original colour…

1 choose an image
A good candidate for a black 
and white conversion should 
have a range of colours to give 
you a wider range of black and 
white looks. Blue skies and 
green vegetation work well.

4 Get selective 
Here we’ve tweaked the B&W 
slider to lighten the grass and 
leaves. This helps the branches 
and clouds stand out more. 
We’ve darkened the blue sky to 
give the clouds more impact.

2 Adjust image
After choosing a shot for mono 
conversion, click the Edit Photo 
button at the top right. Click 
Adjust to access a range of 
tools. At the bottom right you’ll 
find the Black & White controls.

5 Adjust midtones
The Neutrals slider tweaks the 
intensity of the midtones. By 
dragging it left we can darken 
the midtones and reveal more 
contrasting texture in the 
brickwork and clouds.

3 experiment 
Drag the B&W slider around to 
experiment with different looks. 
If you drag the slider left you’ll 
darken green objects such as 
grass and trees, enabling other 
areas to stand out in contrast.

6 tweak tone
Drag the Tone slider right to 
darken shadows and lighten 
highlights. This makes dark 
shapes such as the trees in 
our image stand out more in 
contrast with the white building.

Go further
Enhance your black and 
white prints with these 
advanced techniques

Vignettes
In the Adjustments window click 
Add and tick Vignette. Drag the new 
Vignette slider right to darken the 
edges of the frame. This mimics the 
look produced by more primitive 
lenses and adds mood. 

To add extra texture 
and mood you can 
mimic the black and 

white look produced by retro 
analogue cameras. By using 
advanced tools you can add 
artefacts such as vignetted 
edges. You can also add 
clumps of analogue film grain.

extra definition
Go to Add and tick Definition. By 
dragging the Definition slider to 
the right you can increase midtone 
contrast even more, tease out delicate 
textures and create a black and white 
print with more punch.

Go with the grain
Drag the Black & White panel’s Grain 
slider right to add clumps of film grain 
to the mono conversion. Digital noise 
is sharp and ugly, but analogue grain 
has a more natural organic look.

copy 
and paste

Once you’ve converted a 
summer snap into B&W, go to 
Image>Copy Adjustments. You 
can then choose another shot 
from your library and choose 
Image>Paste Adjustments 

for an instant mono 
conversion.
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3 Advanced colour correction
Click Add. Choose White Balance from the 
Advanced section. Click the eye dropper on an 
area that should be a neutral grey. The tool will 
warm up the sample to remove the blue cast. 

1 colour temperature
Choose a problem shot, click on Edit Photo and 
click the Adjust icon. In this example the colour 
temperature is cold, so the subject looks too 
blue. Fortunately we can warm it up.

4 Adjust for skin tone
When warming a cold shot you risk making 
Caucasian skin look too orange. Set the White 
balance dropdown to Skin Tone. Click on the 
subject’s skin to warm up the shot.

2 clobber colour casts
With cold colours drag the Cast slider to the 
right. This warms up the cold cast and creates 
more accurate colours. You can perform this on 
the desktop or iOS version of Photos.

Adjust 
Levels 
Access advanced tone 
tweaking controls

A picture’s tones are 
made up of a series of 
greyscale levels that 

are represented by a histogram 
graph. This graph displays 
shadows at the left, with 
midtones in the middle and 
brighter highlights at the right.  

1 Summon Levels panel 
Here we have an under-exposed shot. 
The Histogram graph is bunched to 
the left, indicating lots of shadows 
and midtones but a lack of highlights. 
Go to Add and choose Levels. A 
Levels panel will appear.

2 Brighten highlights
Click on the Levels panel’s fly-out icon 
and change the graph from RGB to 
Luminance. This allows you to change 
tones while preserving colours. 
Drag the white control handle left to 
selectively brighten the highlights.

3 Lighten midtones 
Click the grey levels’ control handle 
at the middle of the histogram. Drag 
it left to remap the underexposed 
midtones and give them a brighter 
level. The histogram at the top now 
has a wider spread of tones. 

counteract 
colour casts
Discover more ways to adjust colour

Different light sources produce different 
colour temperatures. As a result daylight 
can look too cool (blue). Indoor light can 

look too warm (orange). Your iPhone’s Camera 
app does its best to automatically balance colour 
temperatures to create natural free colours. 
Here’s a few colour correcting techniques…
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Organise and share your assets
Take more control of your photos and clip collections

By generating clips and stills on a daily basis your 
iPhone’s Photos library will soon become crammed 
with hundreds of files. Fortunately you don’t need 

to rely on your memory of what was shot when in order to 
find and share favourite photos. Your iOS Photos app 
provides a range of automated ways to organise your files. 
As well as gathering files according to where and when they 
were shot, you can even search for images based on their 
subject, without assigning a single keyword. 

1 time and place
Photos automatically gathers images 
into collections based on a criteria such 
as where or when images were shot. 
Tap Memories to see collections such 
as Best of The Year.

2 Make a movie
Tap on a Memory and you’ll preview its 
contents via a series of cuts and mixes. 
Hit play and Photos creates a memory 
movie with transforms, transitions, 
music and even split screen effects. 

3 customise movie
As the Memory movie plays you can 
tap a mood label to change the font, 
transitions and music used. You can 
also customise its duration. Tap Share to 
send it to Facebook, YouTube etc.

The most common way  
to organise images is to 
display them chronologically, 
which your Photos app 
does using its Years view. 
Photos also uses time to 
gather relevant images into 
Memories that you can 
share as movie slideshows.

Making 
memories

1 choose your favourites
Tap People. Drag favourite people into 
the top of the screen. Or tap Select and 
then tap on multiple thumbnails. Click 
the Favourite label to add the selected 
thumbs to the Favourite section.

2 Hide strangers
Photos will select the faces of random 
strangers too, so once you’ve favourited 
friends and family tap Show Favourites 
Only. Now only collections of your 
favourited friends are visible.

3 Label your friends
Tap on a favourited person’s thumbnail 
to view all the images that have been 
gathered there by Photos. Label the 
person. New photos of that person will 
automatically be added to their album.

To access images using 
a range of criteria tap on 
Albums. Photos recognises 
individual faces in your 
photos. You can use this 
feature to automatically 
gather multiple photos of 
your favourite people into 
easy to find collections. 

Find your 
favourite faces

1 find selfies
Go to Albums in the Photos app to see 
a range of automated collections. Shots 
and clips captured using the iPhone’s 
smaller front-facing camera lenses are 
collected in a Selfies album.

2 find places
When you snap a shot on your iPhone 
the image file is geo-tagged with GPS 
coordinates. Photos can use this 
information to display photos according 
to where they were shot on a map.

3 Wonderful widgets
Swipe to your iPhone’s Widgets screen 
to see a Photos widget. This displays 
thumbnails of collections based on 
location and time. Tap on a thumbnail to 
access its collection in the Photos app.

Photos can gather files 
together according to which 
iPhone camera lens was 
used, where the shot was 
captured and even what 
shooting mode (such as 
Burst) was involved. This 
helps you find specific files 
more easily…

Other organising 
methods

Hey Siri
Summon Siri and say 

“Show me photos of dogs”. 
Siri will automatically open 
Photos, search for images 
according to their content 

and display thumbnails 
containing your  
chosen subject. 

Perfect iPhone photos



31

When a friend accepts your invitation to share an iPhone album that you 
created, you’ll receive a notification that they have joined the shared album.

You can set up a 
shared album on your 
iPhone so a group of 

friends can enjoy your pictures 
or clips. Your friends will need 
to have an iCloud account to 
view your shared photos in their 
own device’s Photos app.

1 turn on Sharing
In your iPhone go to Settings>iCloud. 
Tap Photos. Scroll down to iCloud 
Photo Sharing and turn it on. This 
setting also enables you to view 
shared albums created by other 
iPhone users.

2 create an album
Go to Photos. Tap ‘Select’ and 
choose the thumbnails of photos that 
you want to share. Click and drag to 
choose multiple thumbnails quickly. 
Press the Share icon. Click ‘Next’, 
then tap iCloud Photo Sharing.

3 Share the album
Tap iCloud Photo Sharing. In the next 
screen, label your shared album. Tap 
‘Next’ and type in your friends’ email 
addresses. Click ‘Create’, then add 
a comment to introduce the album. 
Finally, click ‘Post’. 

Get your iPhone’s photos to automatically appear in your Mac’s Photos app
use Photo Stream

One common destination for iPhone sourced shots is social networking sites such as 
Twitter or Facebook. This lets people see key events as soon as you’ve snapped them. 

Quick share options

1 choose your shots
In the Photos app, tap to select images that you’d like 
to share. Click the Share icon. In portrait orientation 
you’ll see a range of sharing options below the 
selected thumbs. In landscape orientation click ‘Next’.

2 Share your shots
Tap a destination for your selected images (such as 
Facebook). Type in an explanatory caption for your 
images. You can also tag friends and check-in at 
places before tapping ‘Post’.

 Sign into icloud
Both your iPhone and your Mac need to be signed 
into your iCloud account. On your Mac choose 
Apple>System Preferences. Click the Options 
button by Photos. Tick the ‘My Photo Stream’ box.

 turn on Photo Stream
On your iPhone (or iPad) go to 
Settings>iCloud. Sign into the 
same iCloud account used by 
your Mac. Tap Photos. Turn on  
‘My Photo Stream’.

 Shared shots
Here are collections of photos 
that are being shared by and 
with friends and family members 
via iCloud. We’ll demonstrate 
how to share an album of 
favourite photos with others in 
our sidebar.

 View Photo Stream
Once you’ve turned on 
‘My Photo Stream’ on both 
devices, snap away with your 
iPhone. Once it gets into range 
of a Wi-Fi signal it will upload 
the images via iCloud. You can 
then view them on your Mac 
by clicking here.

icloud photo 
sharing 
Create shared albums 
for a group of friends 
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Share your shots
In pre-digital days we had a tiny trickle of photos to share 
compared with the deluge produced by today’s digital format. 
Our analogue camera’s film canister was converted into 24 or 
36 hard copy prints that we could cherish and share in physical 
photo albums. Today our Mac’s Photos library may be filled 
with thousands of shots that will never see life as a physical 
print, so they run the risk of gathering digital dust languishing 
unseen on a hard drive. 

Fortunately Photos is packed full of functions and features 
that are designed to help share your shots with ease. Here’s 
our roundup of the key sharing options.

Get your photos seen with slideshows, social media and even desktop decoration

Photos

Download available

Time needed

10

Difficulty

Share your photos to a variety of destinationsStep-by-step

1 iCloud sharing 
To share with a group of iCloud using 
friends, select some shots and choose 
File>Share>iCloud Photo Sharing. In the Add to 
Shared Album window click ‘New Shared’.

2 Share with specific friends 
Type a description of your shared photo 
collection. Add a comment too if you desire. 
Use the ‘Invite People’ link to choose Apple 
email addresses from your Contacts list.

3 Desktop and mobile 
Selected iCloud using friends will be able to 
access your collection of images in the Shared 
section of their desktop Mac’s Photos app and 
also via their iPhone’s Photos app.

4 Get social
To share selected shots with a wider group of 
people choose File>Share and pick a social 
network site such as Facebook. Type in a 
description and click ‘Post’. 

5 Create a book
After selecting a collection of shots choose 
File>Create Book. Select a Book Format and 
size (such as Softcover 20x15cm.) Choose a 
Theme for your book. Click ‘Create Book’.

6 Edit the book 
Fine-tune your book’s layout and add captions. 
By clicking ‘Options’ you can zoom and crop a 
shot with a slider and add Filter effects to your 
pictures. Click ‘Buy Book’ when you’re happy.
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If you choose File>Share>More you can access the Extensions panel and 
share your shots to any installed third-party apps such as LinkedIn. 

Desktops, books and calendars 
Customise templates to create attractive books and calendars

 Books and calendars 
Once you’ve started to turn a 
collection of images into a photo 
book or calendar you can access 
and fine-tune your creative projects 
by clicking on them in the Projects 
section of the Photos workspace.

 Fun filters 
After clicking on a 
photo in a calendar or 
book template you can 
quickly adjust its look 
by choosing a filter 
effect. Simply click on 
a filter effect to toggle it 
on or off. You can also 
use the ‘Edit Photo’ 
button to fine-tune 
other properties such 
as Exposure.

 Adjust composition 
After a book or calendar template’s 
layout has been automatically 
populated by your pictures, use 
the zoom slider to change their 
composition. Drag within a zoomed 
photo to show or hide any important 
details hidden at the cropped edges.

 Personalised desktop 
Instead of staring at corporately 
endorsed photography that’s 
associated with various Mac 
operating systems, share your own 
shots as desktop decorations. 
Check out our knowledge base for 
more information.

7 Cool calendars
The process of creating a photo calendar is 
similar to producing a book. After choosing a 
suitable template you can click ‘Options’ to 
change the layout of each month’s collection.

8 Create a slideshow
Select some shots then choose Edit>Create 
Slideshow. Label your slideshow in the text 
field. Choose a Theme, Music and Duration for 
your slideshow. Hit ‘Preview’ when ready.

9 Export your movie 
When you’re happy with your slideshow’s 
look and soundtrack, click ‘Export’. As digital 
photos have a large resolution choose a High 
Definition size for your slideshow video.

 Knowledge base

Create desktop art 
After editing a photograph’s 
colours and tones in the Photos 
app you can share the shot 
straight to the desktop to 
personalise it. Click on a suitable 
shot and choose File>Share>Set 
Desktop Picture. To remove your 
image from the desktop go to 
System Preferences and use the 
Desktop & Screen Saver panel 
to choose another image.



Produce a pet video
People love showing off their pets. Indeed, many pets have their own 
YouTube channel where subscribers can enjoy their ongoing antics. 
Pets tend not to respond well to direction during a shoot, but if you 
film them doing something repetitive (such as chasing a ball) then you 
can capture enough material to be able to stitch clips together into a 
short slick video sequence. 

To create a variety of clips for your pet project it’s best to use 
multiple cameras. For our pet video walkthrough here we’ve used 
an iPhone to capture stunning slow motion sequences, a harness-
mounted GoPro to provide a dog’s eye view of the world and a DSLR 
camera for cinematic-looking shots with a shallow depth of field. 
We’ll also plunder iMovie’s themed assets to give your pet project a 
polished look.

Shoot and edit pet-themed clips into a slick sequence

iMovie

Time needed

10

Animals in action
Combine clips and assets to create a perfect pet project

 Knowledge base

Pet shooting tips
To create the dog’s point of view 
clip for our pet project we bought an 
Aodoor Pet Harness from Amazon 
for £10.99. Due to the spaniel’s small 
size, the harness tended to slip 
around her back as she ran, but with 
persistence we were able to capture 
a few seconds of fun footage to add 
to our sequence.

 Icing on the cake  
Themed titles help introduce your 
pet (and other protagonists) to 
their audience on social media. 
Titles also help give a video a 
more professional look.

 POV shot 
Mount a lightweight GoPro camera to your pet to 
capture unique POV (Point Of View) camera angles 
that add texture and variety to your sequence.

 SloMo
Our pet project contains a range 
of clips sourced from a variety 
of devices. An iPhone’s SloMo 
mode provides an effective way 
of showcasing a fast moving pet. 
Slow motion also adds variety to 
your video.

 Themes  
You can add a Theme to 
a project at any time (or 
change existing Themes) 
by clicking on the Settings 
icon. This gives you 
access to the Change 
Themes browser where 
you can add new themed 
transitions and titles to 
your pet project.

Difficulty

34
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After deleting some of a new Theme’s automatically added transitions use a 
clip’s trim handle to restore any missing frames from its start and end points.

Shoot and edit your pet video Step-by-step

1 Import assets
Go to the Projects tab and click ‘Create New’ 
and choose ‘Movie’. Click the ‘Import Media’ 
icon. Browse to our project’s downloadable Pet 
Source Clips Folder. Click ‘Import Selected’.  

2 Add clip to timeline 
Select Shot01. Click the ‘+’ icon to add it to the 
timeline. This clip was captured on a DSLR. A 
wide aperture setting creates a shallow depth 
of field which blurs the background. 

3 Match movement
Add Shots 02 and 03 to the timeline. Trim a 
few frames from the end of Shot 02 and from 
the start of Shot 03 to create a continuity of 
movement for the little girl’s ball throw. 

4 SloMo mode
Shot 03 was captured using an iPhone’s SloMo 
mode, causing the action to start at normal 
speed, ramp down to slow motion and then 
back to normal speed at the end.

5 Flip for continuity 
Add Shot 04. To make the pet run in the same 
direction as in the previous clip, click the Clip 
filter icon above the viewer. Click ‘Clip Filter’ 
and choose ‘Flipped’.

6 Point Of View  
Add Shot 05. This frenetic clip was captured on 
a GoPro mounted to our ball-chasing pet via a 
harness. This filming technique adds variety to 
the project and gives us a fun POV scene.

7 Add last clip 
Add Shot 06 to the timeline to complete the 
story, as the dog returns the ball. Here we’re 
back to a DSLR clip. The background blur 
makes the pup and her pal stand out.

8 Choose a Theme
Click ‘Settings’ at the bottom and then select 
‘No Theme’. In the Change Theme window 
click ‘Playful’ followed by ‘Change’. This 
automatically adds themed titles and transitions.

9 Finishing touches
Feel free to remove any transitions that don’t 
work or are distracting. Double-click on a Title 
bar to edit its contents. Add music from the 
Audio browser’s Jingles folder to link the clips.



Sharpen your project’s timing
When it comes to music, like comedy, the notion of good timing 
is pivotal. In GarageBand this is no exception and therefore no 
laughing matter when things skip a beat. Thankfully, the app 
avoids this for the most part by ensuring regions and loops 
adhere to a strict project tempo. Set to 120bpm by default, 
this can of course be adjusted in real time to slow or speed 
performance. Region ‘timing’ is then linked to this but isn’t 
exactly the same thing, being more about where notes or 
peaks fall either side of the beat. Here GarageBand provides 
tools for tweaking tempo and correcting timing including Flex, 
Quantization, plus Tempo and Groove Tracks. In this guide we’ll 
overview each technique to better understand how they can 
sharpen up wayward timing. 

Discover the central tools at the heart of GarageBand’s time-keeping features 

Time needed

18

Finding time
Identifying the most important workspace controls when it comes to manipulating project timing

 Knowledge base

Tempo automations
Timing may well be technically 
different to tempo, but usually 
‘good’ timing is linked intrinsically 
to a rhythm track driving the pace 
of a song. There will be times when 
you want overall tempo to adjust 
at specific moments and this is 
achieved via Track>Show Tempo 
Track. Here automation points can 
be plotted to lower or raise the 
overall bpm rate. 

 Flex Time 
The timing of audio regions can be 
manually edited using Flex. In the 
Editor panel, a series of markers are 
added on the waveform to create 
handles that can be dragged to 
stretch or compress time.

 Quantize Control 
Time Quantize controls including a 
dropdown and strength slider are 
shown within the Editor inspector 
for selected MIDI or Audio regions. 
These shift the timing of all or 
selected notes by a set value. 

 Groove Track
The Groove Track isn’t 
an extra track at all, but 
marks a particular project 
track as a timing leader. 
Denoted by a star within 
the track’s header, any 
others selected will match 
that track’s timing.

 Tempo Track  
This special project track 
is dedicated to adjusting 
the project tempo during 
a project’s duration, 
speeding up or slowing 
things down. Tempo 
changes, controlling bpm 
increases or decreases, 
are applied using 
automation curve points.

Difficulty

36

GarageBand
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Only a single track in a project can be selected as a groove track for others 
to follow, with time quantization then made unavailable for those tracks.

Improve your project’s timingStep-by-step

1 Enable Flex
Flex is used to edit the timing of audio regions, 
by first ticking the Enable Flex checkbox inside 
the Audio Editor inspector. Once enabled, 
markers show on the waveform.

2 Adjusting time 
Each black vertical line is a Flex marker that 
can be hovered over, clicked and dragged 
horizontally. This stretches or compresses the 
interval between to adjust timing.

3 Adding markers
Click a waveform peak to add extra markers 
and drag these to line up with beats or peaks 
within other tracks. Double-clicking or clicking 
the ‘X’ icon deletes any marker.

4 Quantizing MIDI
Quantizing can be used to automatically correct 
timing for both region types. First select one 
or more MIDI regions in Tracks view, or select 
notes within either Editor.

5 Quantize controls 
Use the Time Quantize menu to pick the note 
value for quantizing the timing of the selected 
regions or notes. The slider, available for 
regions only, dictates the Strength.

6 Quantizing Audio  
Selected audio regions can be quantized in the 
same way when they exist in the same track. 
Here the menu and slider are located in the 
Region tab inside the Audio Editor.

Timing can also be corrected by matching the timing 
of multiple tracks to that of a master or ‘Groove’ track. 
GarageBand does this automatically and non-destructively, 
meaning it can simply be turned on and off without editing 
a region. To use this technique, first navigate to Track>Track 
Header>Show Groove Track from the main bar. With it 
shown, you can then toggle which project track is designated 
as the Groove Track before picking those that will follow.

1 Starring role   
You will want to pick a track that sets the timing 
most accurately within a project. Hover the 
mouse pointer over the left edge of the chosen 
track header to see a star. Click to mark this as 
the Groove Track.

2 Following stars 
All subsequent project tracks now display little 
checkboxes to the left of their headers. Clicking 
these on instantly toggles their timing to precisely 
match or follow that of the selected Groove Track, 
while toggling them off removes the changes. 

Using the  
Groove Track

“Match the timing of multiple 
tracks to a ‘Groove’ track”
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How to resequence audio
Logic’s EXS24 sampler has been a part of the app since long 
before Apple purchased Emagic in 2002, which you could 
argue makes it a bit long in the tooth. It’s still incredibly useful, 
however, especially when you consider one particular talent 
it has which you may not be aware of – the ability to import 
any audio region, slice it up and instantly arrange the chunks 
as samples over the length of your MIDI keyboard. It’s a great 
way to resequence drum loops to create new variations and 
fills, excellent for arranging vocal ad-libs as a performance, and 
just a brilliant one-click way to expand your library with custom 
sampler instruments. Follow the tutorial to see how it works…

Quickly transform loops and expand your EXS sampler library

Create new sampler instrument tracksStep-by-step

Download available

Time needed

20

Difficulty

1 Import audio
First off you’ll need to import the audio file  
LPX EXS Loop.wav from the Tutorial Files folder 
onto an audio track in an empty Logic project 
at 128bpm.

2 Select & convert
Highlight the selection, then right-click and 
choose Convert>Convert to New Sampler 
Track. Alternatively, you can use the Ctrl+E 
keyboard shortcut.

3 Zone in
In the dialogue box that appears, you can 
select either regions or transient markers from 
which to create sample zones. As we’re slicing 
up a drum loop, we’ll pick transient markers.

4 Name your patch
In the Name box, enter the name for your 
newly-created EXS Instrument. This is how it 
will appear in your preset list after saving. We’ll 
go for ‘EXS Drum Loop’.

5 Set trigger notes
The trigger note range specifies the area of the 
keyboard that the audio samples will occupy. 
The number of slices that will be created is 
shown in the lower box.

6 Okey dokey
Click ‘OK’. A MIDI region will appear in the 
Tracks area. This will play back the sampled 
chunks in order and in time to replicate the 
original file exactly.

Logic Pro X
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To save the samples you’ve created into a project, enable ‘File>Project 
Settings>Assets>Copy EXS Instruments and Samples into Project’.

Instant replay
Add extra variety to a simple drum loop with this quick feature

 Knowledge base

Tempo change
Time-stretching rhythmic audio 
over large jumps in bpm can 
sometimes have a detrimental 
effect on both the sound and 
the timing. With this technique, 
as the audio is split into chunks 
that are then triggered by notes 
in a MIDI file, you can change 
the tempo with the timing of 
the slices intact, without time-
stretching. This preserves the 
original audio quality.

 Marker respect
Logic uses Flex Time to analyse 
the audio file and place transient 
markers accordingly. The 
‘Convert to New Sampler Track’ 
feature bases the position of its 
slices on these markers.

 One shot
With this option ticked, 
each sampled chunk of 
audio will play through 
to the end of the slice 
regardless of the length of 
the trigger note. Useful for 
loops and drum sounds.

 Regional variations
Alternatively, you can use the scissors 
and fade tools to create a number of 
audio regions by hand, which takes a 
bit more time and effort, but can yield 
a more accurate result.

 On track
As well as the methods already 
shown, The ‘Convert Regions to 
New Sampler Track’ command 
can also be found in Logic’s main 
Track menu.

7 MIDI playback
The original audio track will be muted, with the 
new MIDI track now active. Double-click the 
MIDI region to view the slices and play your 
MIDI keyboard to hear them.

8 Speed it up
If we now change the project tempo to 
170bpm, the MIDI trigger region will speed up 
to match, whereas the muted original audio 
region doesn’t change.

9 Change pattern
We’re now free to go ahead and resequence 
the notes at will. Here we’ve added some  
extra hi-hat, snare and kick notes to form a 
Drum ’n’ Bass-style pattern.
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Get better black and whites
Deprived from the distractions of colour, black and white 
footage helps draw attention to shapes and textures in a scene. 
High contrast monochrome clips also add a classy look that 
harks back to the days of vintage cinema. In fact some recent 
Hollywood films have been re-released in black and white 
special editions. However, by simply desaturating a colour shot 
you’ll end up with a wash of dull greyscale tones. An effective 
mono conversion should add some white highlights and 
contrasting jet black shadows. Here we’ll show you how to use 
a histogram to ensure a striking contrast, and how to mimic 
photography filter effects to selectively darken specific areas in 
the black and white footage based on their original colour.

Create striking arty monochrome conversions with help from histograms and effects

Create classy black and whitesStep-by-step

Download available

Time needed

15

Difficulty

1 Import clips 
Choose File>New Event. Label the Event ‘Black 
and White’. Tick ‘Create New Project’ and 
choose File>Import Media. Browse to select 
our supplied start files. Click ‘Import Selected’.

2 Add effect 
Drag the Old Harbour clip into the timeline. 
Go to the Color section of the Effects browser. 
Drag the Black & White effect’s thumbnail onto 
the clip to create a range of greyscale tones.

3 Selective colour adjustment  
Press Cmd+4 to summon the Inspector. Go to 
the Black & White section. By default the filter 
colour is set to green. Choose red to darken 
the sky and make the building stand out.

4 View the histogram 
Press Cmd+7 to summon the Video Scope 
panel. Click the Scope icon and choose 
histogram. Set the Channels to Luma to see 
the spread of greyscale tones.

5 Brighten highlights
Choose Window>Go To>Color Board. Click 
the Color Board’s Exposure tab. Drag the 
Highlights control up to 13%. This slides the 
histogram’s highlights to the right.

6 Increase contrast
Drag the Midtone control point to -10% and 
drop Shadows to -6%. The histogram graph 
now spreads over a wider range, giving the clip 
more contrasting black shadows and highlights.

Final Cut Pro X
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To summon (or dismiss) the useful Inspector, press Cmd+4, click on its icon 
or choose Window>Show in Workspace>Inspector.

Marvellous monochrome
Create high contrast black and white conversions

Filter effects
Final Cut Pro X’s Black and 
White effect mimics a traditional 
photography technique. When 
shooting with black and white 
film, analogue photographers 
would pop a coloured filter 
over the lens. A red filter 
would darken blue areas in the 
monochrome prints. This made 
blue skies look dramatically 
darker in the monochrome print, 
enabling white clouds to stand 
out more effectively in contrast.

 Knowledge base

 Helpful histogram
This histogram graph shows the spread of 
greyscale tones in our mono makeover. We’ve 
adjusted the tones so that they have a wider 
spread, with plenty of black shadows at the left 
and bright white highlights at the right.

 Black &  
White effect 
This powerful effect 
does more than 
simply removing a 
clip’s original colour 
information. It also 
enables you to lighten 
or darken greyscale 
tones based on their 
original colours.

 Adjust tones  
The Color Board enables you to 
adjust a monochrome conversion’s 
shadows, midtones and highlights 
independently of each other to  
create a more high contrast black 
and white conversion.

 Custom conversions
By clicking on the Black & White 
effect’s colour pop-up in the 
Inspector you can choose a custom  
colour filter. The red filter darkens 
blues in our clip, which is an effective 
way to make the clouds contrast 
more with the sky.

7 Add more punch 
Go to the Blur section of the Effects browser 
and drag the Sharpen thumbnail onto the 
timeline’s black and white clip to tease out 
more of the scene’s delicate texture and detail.

8 Copy and paste 
Click on the timeline clip and choose 
Edit>Copy. Add the Cityscape scene to the 
timeline and choose Edit>Paste Effects to add 
the custom mono conversion look to the clip.

9 Fine-tune the look
The greys in our new mono conversion are a 
little too dark, so go to the Color Board and 
drag the Midtones control point up to 22% to 
lighten them.
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Find ‘secret’ wallpapers on your Mac
Have a nose around the desktop wallpapers on your Mac (in 
the Desktop & Screen Saver window in System Preferences) 
and you may think you have a good selection of images at 
your disposal. But did you know there are many more images 
ready and waiting to be used? You may have seen them when 
you’ve been altering your screen saver but there is an easy 
way of putting them to use as wallpapers too. The 3,200 by 
2,000 pixel images include numerous gems from the lenses of 
National Geographic along with stunning aerial shots, images of 
our wonderful universe and amazing patterns from nature. Here 
we look at how to make the best use of them…

Use the cool screen saver images tucked away on your Mac as wallpapers 

Time needed

10

Difficulty

Add and use extra wallpapersStep-by-step

1 Find the wallpapers
Four folders full of images are stored in a parent 
folder called Default Collections. To quickly 
find them, click the magnifying glass on your 
desktop and open Spotlight.

2 Select the folder
Search for ‘default collections’. Select the 
Default Collections folder in the results and 
explore the image folders National Geographic, 
Aerial, Cosmos and Nature Patterns.

3 Add to screensavers 
You can right-click a thumbnail and select 
Services>Set Desktop Pictures to set it as 
wallpaper or import the folder by clicking 
System Preferences>Desktop & Screen Saver.

4 Import the images
In order to import one or all of the four hidden 
image folders, simply start by clicking the ‘+’ 
button beneath the navigation list on the  
left-hand side of the window.

5 Find the folders
Now navigate to Library/Screen Savers/
Default Collections and select the folder with 
the images that you like. You can add all four 
folders if you wish, one at a time.

6 Choose your wallpaper 
Once a folder has been added, you can click it 
and see the images it contains, each displayed 
as a thumbnail. Clicking an image will instantly 
make it your wallpaper.

macOS
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Got a 12.9-inch iPad Pro? Then you’ll be interested to hear that the iOS 
10.3.3 beta has introduced three new nature-based wallpapers.

Understand the Desktop & Screen Saver interface
Discover how you can better freshen up your desktop and manage your wallpapers

 Knowledge base

And there’s more… 
from Google
If you’re after some fantastic 
screen savers as well as 
wallpapers then be sure to 
check out the many images 
being offered by Google+. By 
visiting https://plus.google.
com/featuredphotos, you 
can download a fantastic 
screen saver made up of high 
resolution photographs taken 
by members of the Google+ 
community. Any images you 
share publicly will also be 
considered for inclusion: who 
knows, your own photos may 
form part of a screen saver for 
millions of others to enjoy.

 The red button
When you select a wallpaper it will 
instantly become your desktop. There is 
no need to press a save button. Instead, 
just click the red close button in the top 
left-hand corner.

 Add and remove
The ‘+’ button enables you to add a 
folder to your list of wallpapers. But if 
you wish to remove a folder instead then 
simply highlight it in the list and select 
the ‘–’ button.

 Random ordering
If you really want to live life on the edge, 
then you can have the Mac decide which 
wallpapers to show and when. To do this 
just select the option for ‘Random Order’.

 Change picture
If you want to add some variety to 
your desktop throughout the day, 
you can decide to rotate through the 
wallpapers. Click the button next to 
‘Change picture’. Choose from every 
five seconds to every day.

The hidden images we are discussing here were actually 
intended to be used as part of a screensaver so they are not 
of the high resolution you may expect of a standard Apple 
Mac wallpaper. They will appear smaller than usual on Macs 
that have a hi-res display but if you really love the image 
there are some things you can do to make them look better 
on your screen. The options are contained in the Desktop & 
Screen Saver window in System Preferences.

1 Filling the screen 
By default, an image will fill the screen and you 
may well be happy with that. On some displays, 
this can result in a lack of sharpness, however, so 
you might want to try one of the different options 
instead. Click the dropdown menu.

2 Select another option 
There are four other options. You can fit the image 
to the screen which usually results in bands 
either side (handy for placing icons). You can also 
stretch it to fill the screen, centre it or, if available, 
use it as a tile. Play around until you’re happy.

Make the most  
of your images

“They will appear smaller on 
Macs that have a hi-res display”



Transfer files from Mac to Android
Although some of us stay rigidly loyal to Apple in terms of 
computers, phones and tablets, not every Mac user owns an 
iPhone. And while there have always been ways to connect 
Android smartphones to Macs to transfer and sync files, these 
have not always proved efficient and many users experience 
connectivity issues that prevent data from being transferred.

However, we have found a decent alternative to the likes of 
Android File Transfer and Smart Switch that not only allows 
you to transfer data from your Mac to your smartphone quickly 
and easily, but also wirelessly too. The HandShaker app can be 
downloaded for free from the Mac App Store and is a breeze 
to set up and use. Here we guide you through the process and 
show you how to copy music from Mac to smartphone. 

The HandShaker app is a great way to transfer files between a Mac and an Android phone

Time needed

10

HandShaker interface
The easier way to transfer files from Mac to Android

 Knowledge base

A reliable alternative
The HandShaker app can be used 
as a more reliable alternative to the 
Android File Transfer and Smart 
Switch Mac apps that have proved 
problematic to some Android phone-
owning Mac users. The fact that you 
can connect wirelessly also makes 
it easier and more convenient to 
use than the aforementioned apps 
because they require tethering your 
Android device to your Mac via USB.

 Select and delete 
You can delete content from your 
device by clicking on it to highlight it 
and then clicking on the red trashcan 
icon that will be displayed in the 
top-right corner of the interface. A 
prompt will ensure nothing is deleted 
by mistake.

 Android files 
By clicking on ‘Files’ all of the 
apps and services on your Android 
device will be listed with their own 
respective files. You can drag 
content from your Mac into these 
files to copy it. For example, copy 
music files in the ‘Music’ folder.

 Phone info
Basic info about your Android 
device will be displayed here, such 
as the model, current battery level 
and the amount of storage that 
has been used/is available.

 Media 
categories  
All of the media categories 
will be listed here. Click on 
one, ‘Gallery’ for example, 
and you will be able to 
select images on your 
Android phone and then 
drag them to your Mac.

Difficulty

46

HandShaker
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The HandShaker app is regularly updated so as to work efficiently with the 
latest version of Android, so make sure you check for new updates.

Transfer Mac media files to AndroidStep-by-step

1 Download the app
Download the HandShaker app to your Mac 
from the Mac App Store. On your Android 
phone go to www.devfiles.co/download/
N4W59ABM/HandShaker.apk and download.

2 Launch app 
Launch the HandShaker app on your Mac and 
a box will flash up inviting you to launch the app 
automatically when you connect your device. 
Click on the ‘Launch Automatically’ option.

3 Connect devices
Install the apk file on your Android phone and 
launch it. If both devices are connected to the 
same Wi-Fi your Android device should appear 
on the Mac scan screen. Click on ‘Connect’.

4 Explore the interface
Once connected, the HandShaker interface 
will appear on your Mac. This displays basic 
storage info in the lower-left corner and various 
categories in the column above. Click ‘Files’.

5 Copying albums 
Select ‘Music’ and on your Mac go to albums 
you wish to transfer to your Android device by 
going to Users>[user name]>Music>iTunes> 
iTunes Media>Music. Drag files to copy them.

6 Confirm process  
Once your music files have been transferred, 
click on ‘Music’ in the left-hand column and the 
music you copied should be listed. Launch the 
Music app on your Android phone to check.

If you are experiencing problems connecting your 
Android phone to the HandShaker app then you can 
connect your Android device to your Mac via USB. To 
ensure that this is possible you will need to enable the 
USB Debugging mode on your Android device. The 
only time you really need to connect via USB is when 
transferring large amounts of data, though you can still 
do this over Wi-Fi if you are patient. 

1 Go to 
Settings   
Ensure that your 
phone is updated 
to the latest version 
of Android and then 
launch the Settings 
app. Once this is 
done, scroll all the 
way down to the 
bottom and you will 
see a set of options 
called ‘Developer 
Options’. Go ahead 
and tap on this. 

2 Activate USB 
Debugging 
Scroll down through 
the Developer 
options and you will 
see a section called 
‘Debugging’ and an 
option called ‘USB 
Debugging’. Ensure 
that the slider next to 
this option is turned 
on and it will open the 
gateway to transfer 
data between your 
Mac and your phone.

Troubleshooting

“You will need to enable the 
USB Debugging mode on 
your Android device”
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How to type any character you need
The Mac’s keyboard has 26 letters, 10 numbers and a few 
symbols, but there are actually hundreds of characters 
including accents, umlauts and more. There are sometimes 
eight or nine different variations of a single vowel for example. 
There are hundreds of emoji characters and pictographs. 
Currencies from around the world use special symbols, there 
are maths symbols, Greek letters and many more. How do you 
enter all these characters? There are a couple of ways and one 
is to use the keyboard viewer, which shows how modifier keys 
like Option change the character typed. Another way is to use 
the Character window to select characters and symbols. 

Discover how to enter characters like accents and symbols which aren’t on the keyboard 

macOS

Download available

Time needed

10

Emojis and more!
Every character option you need

 Knowledge base

Compatibility
Although the Pages app was 
used for our screenshots and 
examples, these characters are 
widely supported. They work in 
most apps plus you can copy 
and paste them. For example, 
enter an emoji, select it, press 
Cmd+C to copy it, open another 
app and press Cmd+V to paste 
it. Special characters are not 
supported everywhere though.

 Keyboard 
viewers  
Add this menu bar item in 
System Preferences and 
click it to show the emoji 
and keyboard viewers. 
They help you to find  
and enter any character 
you need to enter into  
your documents.

 Keyboard display  
This onscreen keyboard is 
not static and it changes 
depending on which keys 
are pressed. These are the 
symbols and characters that 
are entered when the Option 
key is held down for example.

 Fun characters 
To enter fun characters like 
these weather symbols, press 
Ctrl+Cmd+spacebar. This opens 
the Characters window and you can 
browse the categories or use the 
search function to find them.

 Accents  
To type accented characters 
like this one, press and hold 
the key until a widget appears 
containing all the character 
variations. Click the one you 
want or press the number 
below it.

Difficulty
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Learn to type awkward charactersStep-by-step

Mac keyboards have changed a little over the years, so the characters you 
get on an old Mac may not be the same as with a new one.

Holding down the Ctrl, Option, Shift and Command keys 
on their own or in combinations affects the character that is 
entered when a key is pressed. It is impossible to remember 
them all, so there is a handy keyboard display that can be 
shown. To resize this keyboard, position the mouse one pixel 
above the top edge and click and drag it up or down. It can 
be made as big or as small as you like.

1 Add menu tools 
Add a menu bar icon by going to System 
Preferences and clicking the Keyboard icon. 
Select the Keyboard tab and tick the box next to 
‘Show keyboard and emoji viewers in menu bar’. 
Click the icon to see them.

2 Check the keyboard 
When you need to enter a symbol or character 
that is not on the keyboard, click the menu bar 
icon and select ‘Show Keyboard Viewer’. Press 
Shift, Ctrl, Option or Command and you are 
shown what character each key produces.

Show the keyboard

“Holding down the Ctrl, Option, 
Shift and Command keys 
affects a character entered”

1 Typing accents 
Suppose you are creating a document and 
need an accented letter. Long press the letter 
until this widget appears. Press the number 
under the character you want.

2 Enter emojis 
Emojis are fun characters that you might want 
to use in documents, emails or messages. 
Press Ctrl+Cmd+spacebar to display this 
window and double-click the emoji you want.

3 Enter special symbols 
There is more than just emojis. Select ‘Letterlike 
Symbols’ on the left to see these characters. 
Browse the font variations in the bottom-right 
corner and double-click one.

4 Search for symbols
There are hundreds of characters, so use the 
search box in the top-right corner to find the 
ones you want. For example, type ‘weather’ to 
see all the weather symbols.

5 Most used characters 
Select ‘Frequently Used Characters’ at the top 
of the sidebar to find something you have used 
before. Click the gear and select ‘Clear…’ to 
remove old ones from the list.

6 More characters 
Click the gear and select ‘Customize List’ to 
see the full list of characters. You are currently 
only seeing about half the collections. Tick the 
boxes for more characters.



Use bookmarks in Pages documents
Sometimes we read documents and eBooks all the way 
through from the beginning to the end. However, sometimes 
we scan them, our eyes glancing over the text going forwards 
and back, looking for the information we need. So why not 
make it easier for readers of long documents and eBooks by 
inserting bookmarks?

The idea is the same as links on web pages. Click a 
bookmark’s underlined text and it takes you to another part of 
the document that contains the information you need. A table 
of contents in an eBook or document is handy, but to use it you 
must return to the start. Bookmarks can be within the text at 
key places and can link to related information. This makes them 
very useful. Here’s everything you need to know…

Make it easy for readers of your long documents and eBooks to find key information

Pages

Download available

Time needed

10

Bookmarks basics
Everything you need to know about bookmarks

 Knowledge base

Links, links and links
There are three types of links in 
Pages documents. Choose the type 
by clicking ‘Insert>Link’. Webpage is 
a link to a website or page on a site 
and clicking it opens Safari. Email 
lets you enter an email address and 
clicking it opens Mail and creates a 
new message. Bookmarks are links 
to other parts of the document.

 Add bookmarks  
Open the Bookmarks sidebar and 
click the ‘Add Bookmark’ button 
to insert a bookmark wherever the 
cursor is. If no text is selected, Pages 
will use the first three or four words 
for the name.

 Sort bookmarks 
Bookmark names and the pages they 
are on are displayed in a list. Sort the 
bookmarks by name by clicking this 
column header. Sort bookmarks by 
page by clicking the Page header.

 Clickety click
Click once on a bookmark to go 
to that location in the document. 
Ctrl+click a bookmark for rename 
and delete options. Double-click a 
bookmark to enter edit mode and 
change the name.

 Insert tool  
This is the ‘Insert’ 
button and among 
the many items that 
can be inserted into 
Pages documents are 
bookmarks. They are 
a type of link, similar in 
some ways to a web 
page hyperlink.

Difficulty

50
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If you format your documents and eBooks correctly using titles and 
headings, there is no need to create bookmarks. Use the suggested ones.

Master bookmarks in PagesStep-by-step

1 Create a bookmark
Move the cursor to wherever you want to 
create a bookmark, such as the heading of a 
section. Select the text to bookmark, click the 
‘Insert’ toolbar button and click ‘Bookmark’.

2 View your bookmarks 
After adding one or several bookmarks, click 
the ‘Document’ button in the Pages toolbar 
and then select the Bookmarks tab. Click a 
bookmark in the list to go to the location.

3 Link to bookmarks
Now that we have some bookmarks, we can 
create links to them. Select the text in the 
document you want to link to a bookmark, click 
the ‘Insert’ button, then ‘Link>Bookmark’.

4 Access bookmark options
Pages suggests a bookmark and it may be the 
one you want. If it is not, click the Bookmark 
list. Notice the two buttons here. You can also 
remove the bookmark or go to it.

5 Select a bookmark 
If Pages didn’t guess the bookmark you 
wanted, a pop-up list of bookmarks and 
suggestions can be displayed. Select an item 
on the list to link to that part of the document.

6 Use your bookmarks  
The bookmark looks like underlined text in 
the document. Click it for a little pop-up with 
two buttons. The bookmark can be edited – 
changed or removed – or you can go to it.

7 View suggested bookmarks
When creating a bookmark Pages lists the 
ones you created and suggests others. Where 
do suggestions come from and how do you 
change them? Click ‘Manage Suggestions’.

8 Manage suggestions
The suggested bookmarks come from the styles 
used in the document, such as the title and 
headings. Tick or clear the checkboxes next to 
styles to change the suggestions.

9 Manage your bookmarks
Click ‘Documents’ to open the sidebar and 
click ‘Bookmarks’ to list them. Clicking 
a bookmark goes to that location, but 
Ctrl+clicking displays a menu of options.



52

Extract files with Dr Unarchiver
Although it is possible to create zip archives and extract the 
contents using the macOS user interface, two very important 
features are missing. One is password protection. You cannot 
lock a zip with a password to prevent people from accessing 
the files it contains. Password protection is important if you 
want to send zip files over the internet.

The other missing feature is the ability to extract only the files 
you need. Suppose a zip contains 100 files and you need just 
one. You have to extract all the files and drag 99 to the Trash 
just to get the one you want. Dr Unarchiver enables you to view 
the contents of zips and extract only the files you need.

How to use Dr Unarchiver to view files in archives and extract them quickly and easily

Dr Unarchiver

Download available

Time needed

5

Difficulty

Extract files from zip archivesStep-by-step

1 Install and run 
Dr Unarchiver can be installed from the Mac 
App Store for free. After adding it, click it in the 
Applications folder or in Launchpad. It opens 
with an almost blank window.

2 Open a zip 
If there is a zip file on the desktop or in a Finder 
window, drag it to Dr Unarchiver and drop it. 
The files and folders inside are listed and you 
can see the contents.

3 Quick view files 
Quick Look works just the same as with 
Finder. Select any file in the archive, press the 
spacebar and it opens in a preview window. 
Almost any file can be viewed like this.

4 Extract a file
Select one or more files and click the ‘Extract’ 
button in the toolbar. The ‘Options’ button 
enables you to choose whether to extract all 
archive items or just selected ones.

5 Share a file
Files in zips can be shared on social media and 
with other apps. For example, select an image 
in a zip archive and click the ‘Share’ button. 
Let’s share it in a Facebook post.

6 Post to Facebook 
In the small window that appears, enter a 
comment to go with the item that is being 
shared, such as a caption for the photo. Set 
the options, such as Public and Post.
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Zip is just one type of archive file and there are many more, like RAR, 7z, 
CAB and GZIP. Dr Unarchiver can handle most of them. 

Get to know Dr Unarchiver
Features and preferences for this handy unarchiver

 View zip contents 
When zips are opened the contents 
are listed. Some items that look 
like files in Finder, such as Pages 
documents, are really folders. Treat 
them like files. Select one and press 
space to view them.

 Open zips 
Any zip, even password protected ones, can 
be opened in two ways. Drag the zip to the  
Dr Unarchiver window or right-click a zip file 
and select ‘Open With>Dr Unarchiver.app’.

 Monitor downloads 
Go to the Dr Unarchiver menu and 
select Preferences. There is an option 
to monitor the downloads folder. 
When zips are downloaded you are 
asked if you want to extract them. It’s 
your choice.

 Sort the contents 
The files and folders in the zip archive 
can be sorted by clicking the column 
headings. Click again to reverse the 
sort order. Sort by name, size, date 
or kind to find the files you need.

 Knowledge base

Terminal tips 
Navigating folders in Terminal  
is easy when you know how. 
Type CD followed by a space, 
then drag a folder and drop it  
on the Terminal window. Press 
Enter and it makes it the current 
folder. When specifying what 
files to add to the zip, * means 
any file, *.jpg means any .jpg 
image, and so on. A star saves 
typing filenames.

Zip archives can be password protected. This does not 
prevent anyone from opening the zip. However, it does 
prevent people from accessing any files within it. Double-
click a password-protected zip and macOS immediately 
prompts for a password to continue. Dr Unarchiver asks for it 
when you try to extract files. If you want to send private files 
by email, password protect them in zips first. 1 Use Terminal   

Zip archives can only be password protected from 
the command line, not the graphical interface. 
Open Terminal in the Applications/Utilities folder. 
Change to the folder containing the files you want 
using CD, such as CD desktop.

2 Create a zip 
Type ‘zip -e name.zip file(s)’ to create a zip 
archive. You are asked to enter the password 
twice to confirm it, then the files are added. Use 
a * to add all files and -er to include folders and 
subfolders. For example, ‘zip -e files.zip *’.

Password  
protect archives

“If you want to send private  
files by email, password  
protect them in zips first”



2 Manage apps
Holding down the Cmd key 

and clicking an app in the Dock will 
immediately bring up a Finder screen 
showing exactly where the app is 
on your Mac. You can now delete or 
manage the app as you require. It is a 
huge time saver.

1 Quit and hide
When you navigate between apps 

using the Cmd and Tab keys, you can 
press ‘Q’ when an app is highlighted to 
immediately quit it. You can also press 
‘H’ to hide the app and continue to use 
these shortcuts for as many apps as 
you like with the Cmd key held down.

Full keyboard control
Your macOS keyboard is quicker than a mouse

 No menus
Many keyboard 
shortcuts take the 
place of menus that 
would otherwise need 
to be navigated with a 
mouse. When writing, 
for example, pressing 
one key will keep the 
inspiration flowing 
without interruption.

 Finder shortcuts
It is well worth checking to see which Finder 
shortcuts are available. On a busy Mac loaded with 
thousands of files, the shortcuts available will make 
you a master of locating and managing Mac content.

 Extra options
Some keyboard shortcuts 
show hidden menu 
options in apps and extra 
information in the default 
macOS setup. There are 
a huge number of options 
that can be unlocked 
using your Mac keyboard.

10 Simple macOS 
keyboard tricks

There are many well-known keyboard combinations that let you do 
things on a Mac much quicker than with a mouse, but there are also 
some that add functions you may not be aware of. Chances are that if 
you need to do something regularly, there will be a keyboard trick that 
you can use over and over and it will become so natural to you that 
using the mouse may eventually feel like something you only do when 
absolutely necessary. 

We will highlight some lesser known tricks and also explain what 
they do with the aim that you can use them each day to speed up and 
expand your Mac usage. macOS is designed to utilise the keyboard 
for much more than mere typing in a variety of ingenious ways. 

Add functionality and efficiency through 
your Mac’s keyboard

 The keyboard settings
Take some time to play with the keyboard settings 
to see what can be tweaked to suit your exact 
needs. You may find that some simple changes 
speed up your Mac usage every single day.
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macOS

 Knowledge base

A handy list
Apple offers a list of keyboard 
shortcuts which is useful to 
get you started. It is located 
at https://support.apple.com/
en-gb/HT201236 and will help 
you start to understand just 
how much can be done with a 
couple of key presses instead 
of a mouse. Please remember, 
however, that this list is far  
from complete.



7 Extra menu 
information

Holding down the Alt key while clicking 
a menu option in the status bar at 
the top will present more options 
and information to you. This works 
particularly well in the Bluetooth, Wi-Fi 
and Sound options and gives you much 
more detail than before.

4 Force quitting
If an app is stuck and is simply 

not responding, press Cmd+Alt+Esc 
to bring up the dialogue box which lets 
you quit an application instantly. This is 
obviously very useful so you can quit an 
app that’s not responding and continue 
working straightaway. 

6 What’s playing now?
In iTunes, press Cmd+L to bring 

up the listing for the song that is 
currently playing. This is useful when 
you are navigating through any part 
of iTunes, but want to choose another 
song from the album that is currently 
playing without any delays. 

10 Paste without 
formatting

If you want to strip formatting from text 
that you have copied from the web or 
elsewhere, press Shift+Alt+Cmd+V and 
the text will be pasted plain. This will 
save you from having to reformat the 
text and could become your default way 
to paste content.

9 Find anything
Spotlight works well for finding 

apps and content, but for deeper 
searching of files on your Mac, try using 
Alt+Cmd+Space to bring up a powerful 
Finder window. Now input what you 
are looking for and the results will be 
presented in an instant.

3 Copy screenshots
You may be aware that you can save screenshots using Cmd+Shift+3, but if 

you use Cmd+Shift+Ctrl+3 instead you can capture the screenshot to the clipboard. 
This also applies to dragged area screenshots using ‘4’ instead of ‘3’.

It is advisable to use an official Apple keyboard to benefit from all of these 
shortcuts as they are baked in when used with macOS.

5 Word suggestions
While typing in any application 

that uses word input, press F5 and the 
current word will be used as the basis 
for a list of suggestions you can use in 
place of it. There is little doubt this will 
be one of the tricks you use most.

8 Lose the mouse
As you learn new shortcuts, you 

can start to ignore the mouse for tasks 
such as opening apps. For example, 
press Cmd+Space and then type ‘Mail’ 
to open the Mail app. This saves you 
going to the Dock or the Applications 
folder to find it.



From booking holidays to finding your lost tent at a 
festival, your iPhone is your best summer gadget 
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Y
ou may have found that when you are out and about in 
good weather you use your iPhone less, but it is actually 
the perfect summer companion. Photos look better in 
good weather and the events are more interesting to 

capture, festivals can be organised in minutes with your pocket-
sized computer, and every part of your holiday can be arranged 
from the palm of your hand. Read on for all the best apps and other 
tips and tricks to get the most from your iPhone this summer… 

Holidays
best apps for… booking a holiday

TripAdvisor 
– Hotels 
Flights 
Restaurants

TripAdvisor is a huge name 
in the travel industry and with 
good reason. The interface 
of the app could not be more 
logical and the wealth of 
locations is immense. We 
would always suggest that you 
compare many services, but 
TripAdvisor ticks more holiday 
booking boxes than most.

Expedia 
Hotels, 
Flights & 
Vacation 

Package Deals
The Expedia app is set apart 
by the flexibility it offers and 
the absolute detail you can 
enter in order to book the ideal 
holiday. You get to choose 
each hotel based on a number 
of factors and to then do the 
same with the flights to create 
a perfect bundle.

Airbnb
With more than 
2.5 million holiday 
homes to book 

and some quirky destinations, 
Airbnb offers something a little 
different from the standard 
holiday lodgings. No matter 
what you need, from small 
cottages to hotels to unique 
experiences, you can book 
something instantly and at 
very competitive rates. It’s well 
worth checking out. 

Hotels.com
– Hotel 
booking  
and last 

minute deals
If speed is important when 
booking, this app is great 
for catching the right deal in 
an instant. You can search 
for locations, tap the ‘Book’ 
button and you are on your 
way to taking a much needed 
break in the right place. It’s 
simple and very efficient.

Skyscanner 
– Flights, 
Hotels  
& Cars

This app attempts to give 
inspiration for your next 
holiday as well as simply 
offering a wide range of flights 
and hotels. It is one of the 
better apps to look at before 
you have even decided where 
you want to go and it could 
end up taking you somewhere 
completely new.

Whether you are searching for hotels and flights or need local information,  
your iPhone and a selection of handy apps will have you covered. It will help 
you get from A to B and all the way to Z and will offer you entertainment when you 
want to take a break from the exhaustion of enjoying every minute of your holiday!

Your iPhoNE 
SummEr  
SurvIvAl 

guIdE



1 Choose your 
destination
Open TripAdvisor and tap 
the search bar at the top. 
Type in the destination 
you want to go to and a 
selection of results will 
appear. Tap the one you 
want and you are ready 
to start booking.

3 Who and when?
Now enter the dates for 
your holiday and the 
number of people who 
are joining you. Be very 
careful with each step 
because any mistake 
could cause lots of 
wasted time later on 
trying to fix things.

8 Save the trip
You can save all your 
trip details in TripAdvisor 
so everything is in one 
place. From useful 
flight and hotel booking 
information to simple 
notes to make sure you 
don’t forget everything, it 
all works perfectly.

2 From and to
The next step is to scroll 
down the screen and 
tap the ‘Flights’ option. 
Follow the same search 
process to input your 
departure airport and  
the airport you would 
prefer to land at. It is all 
very logical.

7 Book your room
Again, you will likely 
need to book through a 
third-party site, but the 
process is simple and 
you can be assured of 
good pricing due to the 
way the app scans for 
offers. We still advise that 
you shop around.

4 Select a flight
A list of available flights 
will be presented so 
take your time and tap 
each. There is a lot of 
information included 
such as layover times 
and Wi-Fi availability so 
a few minutes studying 
each will be worthwhile.

Book plane tickets & hotels

6 Find a hotel
The next step is to search 
for a hotel by heading 
back to the search results 
screen. A huge amount of 
detailed information for 
each hotel is included in 
each result which makes 
the selection process 
much easier.

5 Time to book
Once you have selected 
a flight, tap the ‘Book 
Now’ icon and you will 
be taken to the airline’s 
website. Almost all 
booking apps will redirect 
you to a third-party site 
for the actual booking of 
your flight.

Follow our guide to TripAdvisor’s booking function

HoW To…
CREATE A 
READing liST 
in iBookS
1. organise  
your books
You likely have many 
books installed on your 
iPhone and the last thing 
you want to do when 
on a relaxing holiday is 
organise them for beach 
reading. Start the process 
of solving this by tapping 
‘Books’ at the top.

2. A new collection
Now tap ‘+ New 
Collection’ and give it a 
name. This is where you 
will store all of the books 
that you want to read 
when on holiday. It is a 
simple, but very effective 
way to manage your 
reading schedule.

3. Select books
Go back to your book 
collection and tap ‘Select’ 
at the top. Now tap each 
of the books you want to 
read when on holiday and 
then tap ‘Move’ at the top 
of the screen.

4. Your collection
The selected books will 
now be held in your new 
collection and all you 
have to do to access it is 
tap at the top and select 
it. The books will be listed 
and you can start reading 
in an instant.

5. Download  
the books
If you see a cloud icon 
next to any book tap it so 
that all of the books you 
want to read on holiday 
are available without an 
internet connection. 
They take up very 
little space.

6. And relax
All that is left 
to do is relax 
and catch up on 
the reading that 
always seems 
difficult to achieve 
among the daily 
hustle of work and 
life’s numerous  
other distractions.

1

2

3

4

5

6
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Alternative navigation apps
Which of our three top map apps will you be taking on holiday? We compare their features…

All of the main features 
are included such as 
traffic, points of interest 
and multiple navigation 
choices, but certain 
advanced features are 
not yet included. We look 
forward to a navigation 
app that will suit every 
single user in the future.

Audible directions work 
best and are safer, but 
looking at where you are 
visually is important too. 
Apple maps is adequate 
in this department, but 
it can be difficult to see 
what needs to happen 
next because of the 
simplicity of the interface.

Apple maps had a rocky 
start, but time and effort 
has been thrown at it so 
that we can now enjoy a 
solution that is accurate 
on every single trip. It 
does not always pick 
the best route, but it is a 
consistent performer that 
you will learn to trust.

The country coverage is 
very good but there are 
still some areas where 
the maps are not quite 
complete. It is a work 
in progress and the 
newest solution in this 
comparison so we expect 
to see big improvements 
come very soon.

TomTom go
Free + in-App 

Purchases

google Maps
Free

Apple Maps
Free

FEATURES PRESEnTATion REliABiliTY CoVERAgE

google maps is designed 
for the masses and so 
concentrates on the most 
used features. Traffic 
is well integrated and 
you can use multiple 
transport modes in finite 
detail with the maps 
displaying near perfect 
detail every time.

google maps looks 
similar to Apple maps 
when navigating, but it 
offers a wider view by 
default. We found the 
maps to be more intuitive 
and for almost every 
location you get what you 
need to navigate in a safe 
and easy manner.

With possibly the most 
comprehensive mapping 
solution in the world 
behind it, you can be 
sure the navigation in 
google maps will get you 
where you need to go – 
particularly reassuring in 
a foreign country you are 
unfamiliar with.

As much coverage as 
you could surely want is 
included in google maps. 
This will be a worthwhile 
navigational tool to take 
on holiday. You may 
find it’s a good idea 
to download maps for 
certain areas before you 
leave though.

As a commercial offering, 
you would expect more 
advanced functionality 
and you get that here. 
The traffic feature is 
stunningly accurate, as 
are the maps with many 
extra features for anyone 
who needs to undertake 
complex journeys.

go is very close to 
presenting directions and 
maps in a perfect way, 
but it can look cluttered. 
This is in contrast to the 
previous version which 
was much simpler but 
still retained the excellent 
traffic management and 
more advanced features.

The full offline navigation 
feature means you 
can use it anywhere 
and the routes offered 
are arguably the most 
efficient of any solution 
available. It is hard to 
criticise the TomTom for 
reliability as it has been 
honed over many years.

World coverage is 
included in go which 
is a subscription-based 
service, but you will need 
to download the maps to 
your iPhone before you 
leave. This can take up 
a lot of space, but gives 
you full offline access to 
very accurate maps.

Apple maps feels familiar 
from the start thanks 
to the way the controls 
are set up, but it isn’t 
obvious where each 
feature is. With a reliance 
upon displaying the maps 
above all else it is easy 
to forget where all of the 
features are.

EASE oF USE

The reliance on subtle 
cues to tell you where 
each feature is makes 
google maps the easiest 
to use. however, if you 
are accessing certain 
features when doing 
something else, Apple 
maps’ larger icons are  
an advantage.

All of these apps are 
easy to use once you are 
familiar with them, but 
TomTom’s suffers a little 
in the way it displays 
traffic conditions and 
other detail. It is easy 
to access important 
features, but visually it 
could be improved.

best apps for… staying safe on holiday
First Aid by 
British Red 
Cross
A really useful app 

to have on your iPhone which 
is even more vital on holiday. 
Everything is covered from 
giving emergency first aid to 
preparing for earthquakes and 
flooding, and the interface is 
laid out logically throughout. 

geoSure
When travelling 
to more obscure 
countries, there 

may be risks that you need 
to be aware of. geoSure 
makes sure you are aware of 
diseases, local laws and even 
woman’s safety so check this 
app before you even book your 
trip. It could be a life saver.

going 
Abroad
If you are 
travelling in the 

European union, familiarise 
yourself with local laws so you 
don’t ruin your holiday through 
a lack of knowledge. The 
driving rules are very useful 
and you even get some travel 
games to keep the kids happy.

Help Me 
– SoS 
international
hopefully you will 

never need to use this app, 
but if you have an emergency 
abroad you can use this app 
to call the relevant emergency 
services instantly. It uses your 
location to work out the best 
number to call.

Safer Travel
This app works 
like a mini 
encyclopedia 

and will give you all of the 
information you need about 
your holiday destination. From 
useful contact information to 
places to visit, it will keep you 
safe and enhance your holiday 
experience at the same time.

ConClusion: Apple Maps and google Maps are free so there is no reason not to have both installed on your iPhone. For day to day use, TomTom go is a 
superb solution and works perfectly in areas of high traffic. We are not sure, however, if it offers enough over the other two to justify the extra cost. The one 
thing you should take with you on holiday is a navigation app and the good news is that all three of these will prove exceptionally useful.



Perform emergency first aid
1 launch the app
Open the First Aid by British Red 
Cross app and tap the ‘Learn’ icon. 
Now scroll down to what you need 
and tap it to see more information. The 
process throughout is designed to be 
as efficient as possible.

2 Watch a video
The videos at the top of each topic 
are designed to be very quick to view 

and will instruct you visually on the 
best way to deal with any first aid 
emergency. The quality instructions 
throughout are very impressive.

3 Every event covered
You can also read quick answers to 
events that may occur while you are 
trying to help and the information 
included may make all the difference 
in the right situation.

 Make a search 
hit the search icon and google maps 
will present the location you need 
in an instant. The comprehensive 
mapping and google’s legendary 
search capabilities come together 
perfectly in this app for all of your 
navigation needs.

 Types of maps
The presentation is also very well done 
and varied enough to suit each type of 
location. You can choose from the default 
maps interface or satellite and terrain 
views which will each suit different areas.

 Travel modes
Whether you are driving, 
taking the train or walking, 
you will see times and other 
detail for each mode of travel. 
This can be used to decide 
which will be the best way to 
travel when abroad.

 Delays highlighted
The colours used in the main mapping 
screen will highlight delays and the app 
will offer alternative routes if needed to 
help you get to your destinations quicker. 
It takes a lot of the potential hassle away 
from your holiday.

 Simple and reliable
Every piece of information you need 
will be displayed on the one screen. 
At no point will you be unaware of 
how long a journey will take thanks 
to the general accuracy and traffic 
monitoring. It’s so comprehensive.

google Maps
get the most from google’s  
excellent mapping app

 Where am i?
If at any point you get 
lost, simply tap this 
icon and the app will 
immediately take you 
back to your current 
location. Whether walking 
or driving, it is a very 
useful companion to keep 
with you all the time.

1

2

3
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The summer and festivals go together well and this 
is an area where your iPhone will come in particularly 
handy. From finding the best events to securing the 
perfect location to view your favourite artists, the 
iPhone will help you every step of the way. It will also 
enable you to capture those special moments that 
you will want to keep forever.

Festivals

Festvl – 
Uk music 
festivals
With Festvl you 

can check exactly which 
festivals will be available in the 
coming season and you can 
then delve deeper to check 
lineups and full summaries 
as well. It is uK only, but is a 
highly worthy addition to your 
festival arsenal.

Vignette
Combine video 
clips to make fun 
movies synced 

to music. It has never been 
easier to create a short movie 
clip that packs in all of the 
important moments from an 
event. You get to capture clips 
live, throw in a sweet filter and 
a background song and your 
work is done. 

Festival 
Ready
Can a virtual 
Swiss Army 

Knife really work at a festival? 
Yes indeed it can. This app 
includes a host of useful tools 
including a torch, a sound 
flare, live weather and a range 
of useful tips. It is the perfect 
festival assistant which will 
come in handy many times.

Festival 
Flash
If you are 
seriously addicted 

to festivals, this app will let 
you buy tickets instantly and it 
will also notify you when new 
artists are added to lineups 
so you never miss anything. 
Even better, it also offers 
recommendations based on 
your personal music collection.

BC Tent 
Finder
There really is 
nothing worse 

that losing your tent at a 
festival because they all look 
the same and it is possible 
that alcohol will only add to 
the problem. With this app, 
however, you can easily note 
its location before you wander 
off and return at any time.

best apps for… 
enjoying festivals

best apps for…  
keeping info safe

Secret Calculator 
Safe – hide 
photo.s and 
video.s

This clever app disguises your photos 
in an app that looks like a calculator. 
You input your passcode using the 
standard calculator interface and at no 
point does it look like anything other 
than a calculator until you get to view 
your safely secured holiday snaps.

Secure Text 
keyboard – 
Encrypt your 
private messages 

for WhatsApp, email, etc
This is not an app to store sensitive 
information, but in some countries it 

Secret Photo 
Vault, keep 
Password Safe 
locker – lS

The presentation of this app is not 
that personal, but you do get to store 
photos, notes, videos, bank details 
and more in a secure environment 
which has unlimited space. A simple 
solution that does what you need it to.

keeply – Hide 
photos, lock 
notes
Keeply is one of the more 

professional looking secure apps for 
the iPhone and it is also extremely 
easy to use. The security features are 
varied and after a short period of use, 
you may find this to be the only secure 
app you need when on holiday.

1Password 
– Password 
Manager and 
Secure Wallet

Perhaps the most important 
information you carry with you is 
passwords alongside credit card 
details and logins. 1Password secures 
all of this information while making 
logging in as easy as you would want. 

Use keeply to keep 
your information safe

1 Choose  
your security
Go to Settings in the 
app and tap ‘Security 
Settings’. You get to 
choose from a fake 
PIN, a standard PIN 
and Touch ID. We 
suggest you select 
Touch ID and enable 
Face-down lock and 
Intruder Photos.

2 Back it up
Also within Settings, 
tap ‘Sync/Back Up’ 
and then choose 
cloud sync or local 
backup. You really 
should use one so that 
your precious holiday 
memories are not lost 
before you even arrive 
home. Everything is 
covered in this app.

3 Fill it up
Once you have the 
security and backup 
settings done, you can 
start to fill the app up 
with photos, which 
can be automatically 
deleted from the 
camera roll when 
imported, notes and 
passwords. It’s a very 
reassuring experience.
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could be ideal if you believe that the 
messages you are sending could be 
seen. It encrypts your text at source 
when used in messaging apps and  
will offer some peace of mind in 
certain locations. 



 Tools
The tools section is the 
most useful here with 
a sound flare, a torch 
and lEd sign writing 
to help you send 
messages visually. It is 
great to see so many 
carefully designed 
tools in one single app.

 navigator
Festival ready includes the 
ability to mark any location 
and to also find your friends in 
busy crowds. This is a safety 
feature that could save you a 
huge amount of time so that 
you can enjoy the music.

 get your kit
As pay back for the free app, victorinox includes a 
handy section that shows off a variety of purchasable 
gear from knives to tents to wet weather clothing. 
Could the app really be more complete?

 Festival tips
Everything from how to pitch a tent to 
what you should wear is covered in 
the Tips section. There is also a very 
impressive checklist feature to ensure that 
you don’t forget anything important.

How to… Find your lost tent!
lost your sense of direction (and tent!) after a cider or two? here’s how to stay on track…

1 Save the 
location
In the main screen of 
BC Tent Finder, tap 
‘Save location’ to note 
exactly where your tent 
is. You can also snap a 
quick photo to act as a 
visual guide when you 
are looking for it later.

2 A saved tent
A confirmation box will 
appear to show that the 
location is saved and 
you can now enjoy the 
festival without worrying 
how to get back to it 
later. The longitude and 
latitude positions are 
also saved.

3 Time to return
Tap ‘Find locations’ 
and you can then select 
an icon to navigate  
back to your tent. You 
can save as many tents 
as you like which will 
help to make you the 
most popular person at 
the festival!

 Weather 
The weather can make a festival 
great or very wet and one tap on 
this icon will tell you all you need 
to know so that you can dress 
appropriately for the conditions. 
A simple, but effective addition.
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Festival Ready
get to know this multi-functional app
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Inviting friends around for a garden party is one of the best 
things about summer and, armed with your iPhone, you can 
make your alfresco social gatherings truly memorable affairs for 
all concerned. here we show you how you can use your iPhone 
to control the music, adjust the lighting to suit the mood and 
even kick things off with some fun-fuelled party games!

Summer 
parties
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best  
apps for… 
enjoying 
summer 
parties

Spotify: 
listen To & 
Stream Music 
for Free

You have many choices for 
streaming an unlimited supply 
of music at your party and, 
alongside Apple music, Spotify 
has to be one of the best 
options. Set up a party playlist 
ahead of time and you won’t 
be needing a dJ to create a 
decent atmosphere.

iTunes 
Remote
Apple’s remote 
app may seem 

like an obvious choice, but did 
you know that you can use it 
to control music and visuals 
through an Apple Tv which 
can leverage your music library 
from a connected mac? It 
forms part of an entertainment 
system which is sure to rock 
any party.

Sonos 
Controller
Parties need 
music and music 

needs good quality speakers. 
If you want some of the best, 
the Sonos app and related 
speakers give you full control 
over the music in any room 
and let you change the mood 
in an instant. They work 
brilliantly at all other times  
as well.

QuickHue 
– The easy 
to use Hue 
Remote

If you already own hue lights, 
this app will help you to control 
them in a variety of ways using 
simple gestures. Being a good 
party host in 2017 involves 
good music, great lighting  
and the ability to change 
everything right from your 
iPhone in a second.

Happy 
Wheel of 
Fortune – 
Free Spin 

Party games
The blank slate that this app 
offers can be used for decision 
making and for many other 
tasks, but it works best as the 
basis for party games. You can 
personalise it for your guests 
and have fun by changing the 
topics over and over again.

 Discovery
discovery is a major part 
of the Spotify service and 
if you take the time to get 
involved it is likely that you 
will be able to grow your 
musical interests in a very 
short space of time.

 new releases
The latest releases will 
always be available which 
means that you can set 
up the newest tunes to 
keep everyone at the 
party entertained. It also 
makes you look more 
musically informed than 
you may be already!

Spotify
how to discover great 
new music to really get  
your party started



kiT BAg
1. AirPods
The AirPods offer many advantages 
that make them perfect for 
summer fun. Besides the 
excellent sound quality, you 
get a super portable solution 
which offers a huge 24-hour 
battery life thanks to the clever 
battery case. They also connect 
seamlessly with your iPhone and 
include Siri compatibility.

3. Valet Charger™ Power 
Pack 6700 mAh for Apple 
Watch + iPhone
You can recharge your iPhone 
three times with this portable 
charger or use the 
built-in Apple Watch 
charger eight times. 
This makes it the 
ideal charger for 
keeping your Apple 
products on the go when you are 
busy having fun in the sun.

2. Smart Battery Case
With a design that has split 
opinion, the Smart Battery Case 
is an unusual product from 
Apple. It does, however, bring 
a huge improvement to iPhone 
battery performance and will 
be perfect for festivals and long 
days out where you will take 
lots of photos. It also offers 
excellent protection.

4. Journal for iPhone
Why carry a wallet and a phone 
in a case when you can use the 
Journal case instead? It can 
store ID cards, cash, payment 
cards and even cash alongside 
your iPhone, and the end result 
is a portable leather solution 
that does everything. It is also 
very elegantly designed.

5. Macro Pro lens Set
This portable lens set 
will enhance your iPhone 
photography and let you 
take full advantage of the 
bright summer conditions. 
It is well worth keeping in 
a bag for when you want 
to capture something 
close up and may become 
part of your mobile 
photography kit.

 Downloads
Streaming services do not stop you 
from keeping a downloaded library 
of your favourites. You can build 
up thousands of tracks easily and 
enjoy the best of both worlds – all 
of the tracks you want with your 
favourites taking centre stage.

 Playlists
You can find any song in 
Spotify and then take the 
time to create the perfect 
party playlist. A mix of 
classic dance tunes and 
new tracks will ensure that 
the party is memorable for 
anyone who attends.

How to… 
Set up Home 
Sharing
1 Find the settings
In the Apple remote app, tap ‘Settings’ 
in the top right corner to see what 
options are available. The setup process 
for home Sharing only needs to be 
undertaken once and it will work forever.

3 Play the media
You can now play films, music and 
podcasts that are stored on your mac 
directly to your Apple Tv and control 
the entire process with your iPhone. 
It is perfect for any party where the 
entertainment is crucial.

2 Connect your devices
make sure your mac is connected to the 
same Wi-Fi network as your Apple Tv 
and enable ‘home Sharing’ at the top. 
You may need to enter your Apple Id. 
Also enable ‘Stay Connected’.

 great visuals
The visual aspect of Spotify 
ensures that the app is easy 
to navigate which means 
that you can select any track 
or album instantly. It’s a 
friendly environment to play 
millions of tracks within and 
it works very naturally.
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£159/$159
www.apple.com

£99/$99
www.apple.com

£89.99/$99.99
www.belkin.com

£59.99/$69.99
www.twelvesouth.com

£79.99/$79.99
www.olloclip.com
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Download available

Time needed

10

Difficulty

Increase your  
iPhone storage

Inadequate storage is a common problem with iPhones. Once we 
have filled our phones up with photos, videos and music, we all 
too frequently come up against the dreaded iPhone storage full 
warning. So what is the solution? An external storage device!

For the purposes of this tutorial, we have used the 64GB iStore 
‘n’ Go USB Drive from Verbatim (£55.99/$75.99), which is double-
ended with a USB connector on one end and a Lightning connector 
on the other. This peripheral also comes with a free app (available 
from the App Store), that makes it easy to transfer files from your 
iPhone onto the external storage device. So read on to find out how 
to shift your media on to iStore ‘n’ Go.

Free up storage on your iPhone by using an external 
storage device for your media and photos

iStore ‘n’ Go

Using an external storage deviceStep-by-step

1 Insert device
Insert the iStore ‘n’ Go USB drive into your 
iPhone’s Lightning socket and a message will 
pop up saying that the app that the drive uses 
is not installed. Tap on the ‘App Store’ option.

2 Download the app
You will be taken straight to the iStore ‘n’ Go 
app page within the App Store, so tap on the 
‘Get’ button and the app will be downloaded to 
your iPhone. It is only 25MB in size.

3 Open the app
Once the app has installed, open it and then 
the main homescreen will display various 
sections, such as Photos, Videos and Music. 
Start off by tapping on ‘Backup’.
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What’s in 
iStore ‘n’ Go?
How to find your way around the app

 Internal camera app
When the iStore ‘n’ Go device is 
plugged in, tap on this camera icon 
to access your iPhone’s camera and 
then snap away as normal. New 
pictures will then be saved to the 
storage device.

 Backup 
If you backup your iPhone to the external 
storage device, all of your photos and videos 
will be automatically transferred, meaning 
that you can delete them from your iPhone.

 Media categories 
The app interface is easy to navigate, just tap on 
the section icons to access the respective media or 
data files stored on the external storage device.

Whenever you plug the external storage device into your iPhone, you will 
see a message pop up. If you then tap on ‘Allow’, the app will be launched.

 Knowledge base

Snap and save
When the iStore ‘n’ Go external 
storage device is connected to your 
iPhone, you will be able to access 
your iPhone’s camera from within 
the accompanying app and then any 
images or video that you capture 
through it will be saved to the 
external device and not your iPhone’s 
internal memory. Very handy if space 
is particularly tight.

4 Backup data
Tap ‘Start Backup’ and all of the photos and 
videos currently on your iPhone will be backed 
up to your external storage device. Once done, 
you can delete them off your iPhone.

5 Transfer music 
The quickest and easiest way to transport 
music is to copy it from your Mac to the 
external storage device and then delete all of 
the music on your iPhone.

6 Play music
In the app on your iPhone, tap on ‘File/Folder’ 
and navigate to the music that you copied.  
You can now tap on a track and it will start 
playing as normal.

 Available storage
You will be able to see, at a glance, exactly how 
much storage space is available on your iPhone and 
on the external storage device.
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1 Line yourself up  
Tap the Camera icon in the top left-hand corner 
of the app and position yourself in front of either 
the backward or face-forward camera. You can 
take a photo or video.

2 Use a filter 
Select the new face icon at the bottom of the 
screen then choose one of the eight filters that 
will appear, ranging from some furry, twitching 
ears to a pair of nerd specs.

3 Take the shot 
As you move, the filters follow your face. Now 
tap the shutter button to take a shot or a 
recording. Either save it, add it to your story or 
send it through Instagram Direct.

Enjoy Instagram’s 
new face filters

You may get a sense of déjà vu when you start to use Instagram’s new 
face filtering feature. That’s because it looks to have been ‘borrowed’ from 
Snapchat but that doesn’t make it any less fun. Available as of version 
10.21, it allows you to add a series of eight augmented animations which 
stick like glue to your face as you record or take a photo and move around. 
What’s more, it also works with Boomerang which stitches a series of 
images together and creates a forward and backward playing mini-flick, 
bringing extra life to your Instagram content. It’s one of a number of new 
additions to Instagram, another being cool hashtag stickers accessed by 
taking your shot and tapping the Sticker icon in the top-right of the screen.

Make your selfies a bit more fun by using Instagram’s 
new set of augmented reality animations

Instagram

Filter your face on InstagramStep-by-step

Time needed

5

Difficulty
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Turn your iPhone into a dash cam
Dash cams are becoming more popular thanks to YouTube and 
other services showing what they can capture. Whether you 
want to use one to protect yourself in the event of an insurance 
claim or you want to make your own YouTube videos, you can 
do so relatively easily. Taking the idea even further, you can 
actually use your iPhone as a dash cam for virtually no extra 
cost with a simple app and the right holder in your car. The 
setup is minimal and the end result is good enough to use in an 
insurance claim so this could be a good first step in deciding 
whether you want to upgrade to a standalone dash cam. You 
will be ready to record your trips within minutes.

Your iPhone can do many things and this includes taking the place of a standalone dash cam

Create an iPhone dash camStep-by-step

OsmAnd DVR

Download available

Time needed

15

Difficulty

1 Download an app 
There are many apps available that create a dash cam experience, but 
for this tutorial we will use OsmAnd DVR which is free with an in-app 
purchase option to gain extra features.   

3 Check your memory 
Video files take up a lot of memory so make sure that you have enough 
available to start with. The last thing you want is to run out of available 
storage in the middle of a trip.

2 Set it up 
Once installed, you should spend some time exploring the settings and 
choosing what you need. We would suggest that you leave items such 
as G-Sensor enabled as they all have a use.

4 Positioning is vital
You will need to spend some time finding the right phone holder so that 
it can be positioned correctly. Landscape orientation works best and as 
dead centre as you can make it.
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You should be very careful not to mount your iPhone where it could be 
considered to obstruct your view of the road.

5 Time to record 
You can now hit the big red record button and start driving. The iPhone 
will capture what happens, but we would advise you to ensure that it is 
plugged in to save battery life.

7 Play the clip 
A list of clips is available in the front screen of the app and all you need 
to do is select one and start playing it. This is useful for finding number 
plates and other detail. 

6 Full tracking 
GPX tracking is included and exports of your clips will include all of the 
information you need to understand and prove what happened. This app 
solution is complete in every way.

8 Save the clips
In the OsmAnd DVR settings, you can save the clips to Dropbox or a 
Wi-Fi server for safe keeping. Remember that one clip could save you a 
lot of money when used as evidence.

Features and limitations

1 Quick settings
Tapping the top-left icon will bring up a set of quick 
settings that you can adjust as needed. These 
include disabling the microphone and enabling the 
map. Only use these when stationary, however.

2 Car mode
The Car mode displays the current speed, average 
speed and other useful information in an easy to read 
way. The Night mode is also useful when travelling in 
the dark as it offers fewer distractions. 

3 Beware the dark 
The iPhone camera is superb in almost all conditions, 
but be aware that night-time recording from a car 
is less than stellar. For daytime driving, however, it 
works as you need it to.
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Use your AmpliTube 
pedalboards in GarageBand

There is much to enjoy about the latest version of iOS guitar 
recording app, AmpliTube (reviewed last issue), such as a 
rack of new pedals and some authentic-sounding vintage 
amp setups. Well the good news is that you can incorporate 
all of the guitar sounds that you generate in AmpliTube into 

GarageBand to utilise a vast new tapestry of sounds in your 
projects. The feature is known as Inter-App Audio and it 
enables you to route and record the sound output from  
third-party music apps directly into your GarageBand song.

The option to use Inter-App Audio is only available in 
GarageBand 2.0 (or later) when at least 
one other compatible music app is 
installed on your device. Not all third-party 
music apps are compatible though and, 
even though you may be able to select 
a particular app within GarageBand’s 
Inter-App Audio menu, if GarageBand’s 
recording console isn’t present then the 
feature won’t work.

Here we demonstrate how you can 
plug in to AmpliTube’s vast rack of stomp 
boxes and use them in your GarageBand 
project, thus creating a wealth of new 
musical possibilities.

Use GarageBand’s Inter-App Audio to record music and sounds generated in third-party apps

Using Inter-App AudioStep-by-step

GarageBand

Download available

Time needed

20

Difficulty

1 Set up in AmpliTube 
In the AmpliTube app, set up your ideal 
pedalboard, selecting the amp, FX pedals and 
Post FX pedals to obtain the perfect sound. 
Once your rig is complete, double-tap the 
Home button and open GarageBand.

2 Create a new song 
In GarageBand, tap on the ‘+’ icon and choose 
‘Create New Song’ and then you will be able to 
select the instruments to use. Scroll through the 
selection until you get to External. Now tap on 
‘Inter-App Audio’.

3 Choose AmpliTube 
All of the apps that create audio that are 
currently installed on your device will now be 
listed. Select AmpliTube and your pre-selected 
rig will be displayed on screen along with a 
small GarageBand recording console.

“You can incorporate all 
the guitar sounds you 
generate in AmpliTube 
into GarageBand”
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You can record the sound output of an Inter-App Audio instrument to an 
Audio Recorder, Amp or Sampler track in your song.

4 Record your rig 
Tap the red ‘Record’ button within the 
GarageBand recording console and your 
rig setup will be recorded straight into a 
GarageBand track. You can add a Metronome 
in GarageBand to help with your timing.

5 Return to GarageBand
Tap on the GarageBand icon within the 
recording console and you will return to the 
GarageBand app. Tap on the track view icon 
and you will see your AmpliTube track recorded 
into your GarageBand project.

6 Time to experiment
You can utilise a wide range of third-party apps 
to create interesting sounds. These can then be 
recorded into your GarageBand track and you 
can also apply GarageBand’s own selection of 
filters and effects to create something unique.

Inter-App Audio options
Discover these important settings and features

 Knowledge base

Audio Units Effects
You can use Audio Units 
effects to change the sound of 
instruments, similar to plug-ins 
in the track controls. Tap the 
Track Controls button then tap 
Plug-ins & EQ>Edit and tap on 
one of the green ‘+’ icons (or 
opt to replace an existing plug-
in). Now select ‘Audio Units 
Extensions’ and select an effect 
from the list.

 Noise Gate 
You may get unwanted instrument 
sounds when recording a plugged-in 
instrument. By turning on Noise Gate 
you can adjust a slider to set the level 
for reducing input noise.

 Inter-App Audio  
You can select to record 
a sound feed from other 
music-making apps installed 
on your device, potentially 
opening GarageBand up  
to all manner of exciting  
new soundscapes.

 Metronome 
If you enable the 
metronome in 
GarageBand then you 
will be able to hear it 
during the Inter-App 
Audio feed from the 
third-party app – in this 
case, AmpliTube.

 Monitor
If you want to hear yourself playing 
your connected guitar through the 
GarageBand app then you need to 
tap on the guitar lead icon and then 
ensure that the ‘Monitor’ option is ‘on’.
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1 Update iOS
When bugs in iOS are discovered, 
Apple fixes them and releases 
an update. Don’t delay, get it 
straightaway! Go to Settings> 
General>Software Update to install 
updates as and when they arrive.

2 Don’t tap links
Emails can look real, like this one, 
but it’s fake and that ‘Play’ button 
might lead to malware. Be very 
suspicious of emails and don’t 
tap links unless you know they’re 
totally legitimate.

3 Erase the phone 
The iPhone can be erased after 
ten failed attempts to break into 
it if stolen. Go to Settings>Touch 
ID & Passcode. Right down at the 
bottom, turn on the ‘Erase Data’ 
switch to enable it.

4 Deny locked access
Information and functions can 
be accessed when the iPhone is 
locked, such as notifications and 
Siri. Go to Settings>Touch ID & 
Passcode and turn these settings 
off for better security.

Increase your  
iPhone security

If you have an iPhone, you already have one of the most secure 
mobiles available. From the fingerprint scanner to the tracking 
of lost or stolen phones, the hardware and software combine 
to make the device secure and private. However, there are 
several optional settings that affect the security and privacy of 
the iPhone and they may or may not be enabled. By turning on 
these optional features you can make the iPhone even more 
secure, which can never be a bad thing.

For example, advertisers and websites can track you across 
the web, but only if you allow them. The question is, are the 
settings in your phone allowing them? Do you put off iOS 
updates until it is more convenient? It may put your security 
at risk. We take a look at these and other settings to help you 
ramp up your iPhone’s security to the max.

Configure the iOS settings on your iPhone to 
increase security and privacy to the maximum

Settings

Boost iPhone and iPad securityStep-by-step

Download available

Time needed

10

Difficulty
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Safari security
Improve iPhone security with 
these Safari settings

 Block Pop-ups
Many websites have irritating pop-up windows 
and turning on this switch prevents them from 
appearing. Web browsing will be less troublesome 
as it can block ads, phishing and malware.

 Block Cookies 
Nearly all websites use cookies and some won’t 
work without them. Press this and there is an 
option to limit cookies to the websites you visit and 
reject third-party cookies, usually advertisers.

 Do Not Track 
When you visit a website in Safari, the browser can 
send a message to the site asking it not to track 
your activities. Sites can ignore the request, but 
generally it is useful in increasing privacy.

Watch out for phishing emails that pretend to be from Apple. If an email 
says there is a problem with your account, delete the message.

 Knowledge base

Store photos online?
Many celebrities have had photos 
stolen and some were iPhone users. 
This begs the question, should you 
store photos in iCloud using the 
Photos app? As some celebs have 
discovered, it is a security risk. 
Someone, somehow, might get your 
Apple password and access your 
photos. Go to Settings, Photos & 
Camera and turn off iCloud Photo 
Library if you worry about security.

 Fraudulent  
Website Warning
There are fake websites 
that try to trick you into 
revealing login details for 
banks, stores, Apple, and 
so on. There are also sites 
that contain malware. Turn 
this on to increase security 
in Safari.

5 Auto-Lock it
Every time you put your iPhone 
down the screen stays on for a 
while. Someone could use it, so 
lock it. Go to Settings>Display & 
Brightness>Auto-Lock and select 
‘30 Seconds’ (the lowest time).

6 Stop ad tracking
Advertisers want to track you so 
they can target ads. Foil them 
by going to Settings>Privacy. 
At the bottom of the page, tap 
‘Advertising’ and turn on the ‘Limit 
Ad Tracking’ feature.

7 Add a VPN 
A VPN encrypts Wi-Fi and so 
boosts security at public hotspots. 
Go to Settings>General>VPN>Add 
VPN Configuration. Sign up with a 
VPN provider for setup details or 
use an app.

8 Change passcode 
A fingerprint is not needed to 
unlock an iPhone, but a PIN is. 
Change it if you think someone 
knows the PIN. Go to Settings> 
Touch ID & Passcode and tap 
‘Change Passcode’.
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1 Identify some music  
Whenever you or a friend select a track, artist, 
album or playlist within Spotify’s iOS app, you 
will have the ability to generate a code. Simply 
tap the ‘…’ context menu.

2 See the code 
You will see a code beneath the music’s 
artwork. Tapping this lets you save it to your 
Camera Roll, from where you will be able to 
share the image on social media if you wish.

3 Scan the code
Spot a code on a friend’s phone or on social 
media, or see one in print? Then click the 
camera icon to the right of the Search bar and 
scan it. It will play within your app.

Share and find music 
by taking pictures

We’re all familiar with barcodes and QR codes and their ability to hold 
scannable information. So Spotify’s decision to roll out its very own set 
of music-based codes may not, on the face of it, be the most innovative 
of moves. In the ongoing battle with Apple Music, however, they could 
prove quite crucial. By allowing musicians to place them on posters and 
advertisements and by letting users generate them in an instant on a 
smartphone, they have the potential to become ubiquitous. All you have 
to do is scan the code (whether it’s in print or on someone’s phone or 
computer screen) by granting Spotify access to your camera, and within a 
split second you’ll have the music ready to play on your iPhone.

Use the new Spotify codes to find new music and let 
others enjoy what you are listening to

Spotify

Scan a Spotify codeStep-by-step

Time needed

5

Difficulty
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1 Scan it in
Place a document or receipt 
on a plain-ish background and 
run the Scanbot app. Point the 
iPhone at the item and follow the 
instructions, such as ‘Move closer’ 
or follow the arrows.

2 View the scan
Scanbot automatically takes a 
photo when the document or 
receipt is positioned just right. It 
also crops the background out. 
Use the editing toolbar buttons if 
you need to.

3 Name the file 
Press the default filename at the 
top of the screen and then enter 
a new and more descriptive name 
for the scan. Tags, like Receipt, are 
automatically added. Tap ‘Done’ 
once you have finished.

4 More options
The first time Scanbot is used, you 
may see something like this. After 
using it a few times you will see 
your most used items listed for 
easy access. To continue, tap the 
‘More’ button.

Use your iPhone  
as a scanner

A scanner is a device that turns printed documents and 
receipts into images or PDFs. It is like a photocopier, but 
instead of the output being another piece of paper, it is files 
that are saved to disk or uploaded and stored online. There is 
no need to keep bundles of paper that are fading and growing 
yellow with age. Scan everything when you get it and you have 
a pristine copy that you can refer to, email, print or share.

Scanners are bulky devices, but an iPhone fits in your pocket 
and the camera can be used as a scanner. Free scanner apps, 
such as Scanbot (apple.co/2pLkBhu), photograph paper 
documents and save them as PDF files. These can be saved to 
iCloud or other online storage and accessed on your Mac. Here 
we will guide you through the process of using the app and 
show you how to scan and share important documents.

Scan documents and receipts using your iPhone, 
save them to iCloud and email them

Scanbot

Scan documents and save to iCloudStep-by-step

Download available

Time needed

10

Difficulty
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Scanbot features
How to access and use the main screen

 App settings
Press ‘Cancel’ when the app starts and this screen 
appears. Press the gear icon to open Settings. Press 
‘Scan Quality & File Size’ to select the scanning 
resolution from Low, Medium, High and Best.

 Scan something 
The scanning screen is the first one that appears 
when the app is started, so you can tap and scan 
quickly. When viewing your scans, press the big 
plus button here to add another scan.

As you use the Scanbot app, if you select a Pro feature you are asked to 
upgrade. It’s your choice, but all the basic functions are free.

 Knowledge base

Scanning vs photographing
Strictly speaking, this scanner app and others like 
it do not scan. They take a photograph using the 
iPhone’s camera. This results in a slightly lower 
quality than could be achieved with a true scanner. 
However, using your phone is very quick and easy, 
and you always have it with you in your pocket.

 Browse  
your scans
This screen is where 
previous scans are 
listed. Tap a scan to 
view it. Most functions 
on the edit screen are 
for the Pro app, but 
there are useful free 
functions on the ‘Send 
to’ menu. 

5 Save, email, share
The ‘More’ button shows the full 
list of things you can do with the 
scan, such as share it, email it and 
so on. Select ‘iCloud Drive’ so the 
scan can be accessed on your 
Mac almost instantly. 

6 Save to iCloud
The contents of iCloud Drive are 
displayed and swiping up and 
down enables you to see all the 
folders. Tap ‘iCloud Drive’ or a 
subfolder such as ‘Documents’ to 
save the scan.

There is more to Scanbot than the actual scanning function. Some advanced 
features are only in the Pro version, but all the basic tools are in the free 
version. For example, you can apply filters to enhance scanned images, crop 
and rotate them. Scans can also be emailed to others. Let’s take a look…

1 Use editing tools   
When a scan has been created, a 
toolbar appears at the bottom of the 
screen with useful editing functions. 
Tap ‘Filter’ and you can choose 
between colour, grey or black and 
white images.

2 Email a scan   
After scanning something, one option 
is to email it. You can also press 
Cancel on starting the app, select a 
previous scan and select ‘Send to’. 
The scan is automatically attached as 
a PDF file and is ready to email.

Editing and emailing

 Edit options 
Press the pencil icon to 
enter edit mode. This 
enables you to select 
one or multiple scans. 
They can be deleted, 
moved to a new 
location, or the ‘Send 
to’ menu can share or 
email them.
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Lock the Watch display 
when swimming

The Apple Watch Series 2 received a huge applause when it 
became apparent that it had a water resistance rating of 50 
metres. It meant it would continue to work after you had gone 
for a swim, unlike the first version which is only waterproof 
(thereby coping with rain, a few splashes and sweat but not 
much else).

In theory, you can plunge into a pool without causing any 
damage to the Series 2 Watch yet it is still worth taking some 
precautions. Locking the display, for instance, ensures water 
droplets can’t interact with the touchscreen while unlocking it 
activates a built-in function that blasts water out of the speaker, 
keeping it in tip-top shape.

You should also be wary of any chemicals which come 
into contact with the Watch. Give it a rinse in clean water if it 
becomes plunged in chlorinated or salty water and be wary 
of excessively exposing the device to any shampoos, gels, 
perfumes and soaps.

Fancy a dip in the pool? Then make sure your 
Series 2 Watch doesn’t become waterlogged

Clear the speaker of waterStep-by-step

Download available

Time needed

2

Difficulty

1 Lock the Watch
Going for a swim or jumping in the shower? 
Swipe up from the Watch face and tap the 
water drop icon. Alternatively, open the 
Workout app and start a swimming activity.

2 Take a dive 
A water drop icon will appear at the top of the 
screen. This indicates the screen has been 
locked and that water won’t be able to interact 
with the screen. You can now swim.

3 Rinse the Watch 
Once you have finished, wake the screen and 
turn the Digital Crown. After a few seconds of 
doing this, you’ll hear a series of sounds as 
water is ejected from the speaker.

Apple Watch  Normal workouts
You can lock the screen 
when you are taking part 
in any activity. Just open 
the Workout app, select an 
activity and swipe right to 
see this screen.

 Lock the screen
Tap the water icon to lock 
the screen. If you have a 
Series 1 Watch, the icon 
will look like a padlock 
because this version of 
the device doesn’t have a 
waterproof function.

 Turn the Crown
When you have finished 
your workout and you 
want to unlock the Watch, 
you can turn the Digital 
Crown to remove any 
water from the speaker.

 End and Pause
As well as also displaying 
the time and the activity 
you’ve embarked upon, 
this screen allows you 
to pause and end your 
current workout.
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1 Open Watch app  
By default, you can press and hold the Side 
Button on your Watch to make an emergency 
call. To turn it off, go to the Watch app on your 
iPhone and tap the ‘My Watch’ tab.

2 Select Emergency SOS
Scroll down and select ‘General’. On the next 
screen, look about midway down the screen 
and tap the option for ‘Emergency SOS’. By 
default, auto-calling will be turned on.

3 Turn it off
Touch the green slider next to the option 
labelled ‘Hold to Auto Call’ to turn it off. Now 
when you press and hold the Side Button, you 
can’t automatically make emergency calls.

Stop accidentally dialling 
the emergency services

Personal safety is very important which is why Apple built an SOS 
function into watchOS 3, allowing you to make an emergency call 
by simply pressing and holding the Side Button. There have been 
numerous stories of how it has saved lives – including that of a 
student who made such a call when his Jeep flipped over in April 
– and it is a great lifeline for those with health problems. But there 
have also been tales of the function being accidentally activated. If 
this worries you, then it’s possible to turn off automatic dialling of the 
emergency services. You’ll still have access to the feature by going 
to the Power-Off screen and sliding Emergency SOS.

Apple has made it easy to call for an emergency  
on your Watch but you can deactivate it

Apple Watch

Deactivate Emergency Services (SOS)Step-by-step

Download available

Time needed

2

Difficulty
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1 Delve into the settings
Since you cannot turn off read receipts on the 
Watch itself, you need to open the Watch app 
on your iPhone, tap ‘My Watch’ and scroll 
down the screen, before tapping ‘Messages’.

2 Choose the Custom option
On the Messages settings page simply tap the 
option that is marked ‘Custom’. This will allow 
you to make bespoke changes rather than 
simply mirror your iPhone as is the default.

3 Turn off Read Receipts
A number of options will now appear at the 
bottom of the screen. Scroll down and ensure 
that the slider next to ‘Send Read Receipts’ is 
turned off by moving it to the left.

Stop your Watch sending 
Message read receipts

Your Apple Watch is built for convenience. If a notification is sent to 
your phone, you can take a quick peek at your Watch display and, if 
you’re too busy to deal with it at that moment, sort it out later. With 
Messages, however, there is a little problem: the app will sometimes 
send a read receipt to the sender without you having actually 
seen what they’ve written, thus giving the impression that you are 
ignoring them. This happens if you raise your wrist when a message 
comes through and you hit ‘Dismiss’. Luckily, you are able to turn 
off the read receipts on your Watch by customising how Messages 
behaves and stopping it from mirroring your iPhone.

Read a message on your Watch but can’t reply right 
away? You can prevent it sending a read receipt

Turn off your read receiptsStep-by-step

Download available

Time needed

1

Difficulty

 Viewed 
messages
When messages 
have been viewed, 
read receipts are 
usually sent to 
the sender. If your 
sender doesn’t  
get a reply then  
it could lead to 
some confusion.

 Replying to 
messages
Instead of turning off 
read receipts on your 
Watch, you could 
always send a quick 
reply. One nice way is 
to tap the emoji icon 
beneath the message 
and select an emotion.

 Keep scrolling
Scroll down the screen 
and you’ll also see some 
quick replies such as 
‘Thanks’, ‘Cool’, ‘Yeah’ 
and ‘Talk later’.

Apple Watch
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AirPlay Google Photos on Apple TV

If you update Google Photos to version 2.14.0 
then you can beam your photos and videos 
from your iPhone or iPad straight to your Apple 
TV because the app can now make use of one 
of iOS’s most useful features: AirPlay. Only it’s 
perhaps not as straightforward as it could be.

When the feature was announced there was 
little mention of there being no actual AirPlay 
button within the app itself. Instead, you have 
to mirror your iOS device screen on Apple TV 
but thankfully Google has ensured the images 
are not confined to a letterbox or pillarbox. 
Indeed, by trying to fill as much of the screen 
as possible, it makes showing off your photos a 
real pleasure. Here’s how it’s done.

The latest version of the Google Photos app lets you use AirPlay to view images on Apple TV

Set up AirPlay on iOSStep-by-step
Time needed

5

Difficulty

1 Open Control Center 
First of all, make sure your iOS device and 
your Apple TV are on the same Wi-Fi network. 
Then on your iPhone or iPad swipe up from the 
bottom to open the Control Center.

2 Activate AirPlay Mirroring
Tap AirPlay Mirroring to see a list of devices. 
Select the Apple TV that you want to beam 
your photos to. If your Apple TV displays a 
code, input it on your iPhone or iPad.

3 Go to Apple TV  
Your Apple TV screen will instantly show whatever is being displayed on 
your iOS device. Anything you do on your iOS device from this point on 
will be replicated here.

4 Update Google Photos 
Update Google Photos to the latest version or download the app from 
the App Store if you haven’t already done so. Open it and the app will be 
mirrored on your Apple TV.

Google Photos
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When your images appear on your Apple TV display, all of the onscreen 
furniture on your iOS device is stripped away, leaving the photo ‘clean’.

Understanding the Google Photos interface
How to make the most of Google Photos when mirroring on your Apple TV

5 Select an image
Assuming you have uploaded some of your images into Google Photo, 
you can now simply scroll through your photographs and albums on your 
iPhone or iPad. Tap an image to view it.

6 Swipe to view more
Swipe your iPhone or iPad screen to view more images or go back to 
the main stream and select another. Google Photos will attempt to fill the 
Apple TV screen with your shots.

Can I zoom?
When you use your fingers to 
zoom into an image displayed 
on your iOS device, the 
photo on Apple TV remains 
unaffected. But there is a 
way to zoom in using your 
Apple TV remote. Go to 
Settings>General>Accessibility 
and turn Zoom on. Now click 
the remote’s Touchpad three 
times and swipe around to see 
different parts of the image.

 Knowledge base

 Searching for images  
Google Photos uses AI to 
automatically tag images and 
make them searchable. So typing 
‘cat’ in this search bar on your 
iOS device will find any images 
of felines you have.

 Landscape view
When you are mirroring 
Google Photos from your iOS 
device to Apple TV, you may 
feel more comfortable viewing 
the app in the landscape 
orientation mode. Unlock the 
view in the Control Center and 
rotate your iDevice.

 Your images
Tapping on any of your 
images will allow them 
to appear on your 
Apple TV screen once 
you have mirroring set 
up. The cloud icon tells 
you if a photo is saved 
in Google Drive.

 Different sections 
You are able to view images 
that you have stored in both 
the Photos tab and within 
Albums so tap either of these 
on your iDevice when you’re 
linked up with your Apple 
TV to explore your personal 
library of images.
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Genius Bar
Our Apple devices and the software on them are some of the finest 
products on the planet, but even they have their moments. We’re here  
to give you expert advice and get you back up and running in no time

How can I determine what is displayed in the sidebar of my Mac’s 
open windows? iCloud Drive, for example…  Shaun Davies

Contact us today

Accessibility 
This is a selection of 
settings in iOS and macOS 
that let you change certain 
aspects of your mobile 
device or Mac to make 
it easier to use. Useful 
if you have a physical 
impairment or impaired 
vision or hearing.

Clamshell mode 
When you connect a 
closed MacBook to an 
external monitor and then 
use it like a desktop Mac 
with an external keyboard 
and mouse.

iCloud Drive
This is where important 
macOS and iOS data is 
stored in the cloud and 
made accessible for other 
devices connected to the 
same iCloud account.

Sidebar 
This is the bar at the side 
of Finder windows on your 
Mac that lets you quickly 
access apps, services 
and devices. It is fully 
customisable through the 
Finder Preferences.

You can set your 
sidebar up however 

you want…

1 Finder Preferences
Start off by clicking on the ‘Finder’ 
menu item and then click on 
‘Preferences’ to access a set of 
options that are separate from 
your System Preferences.

2 Click Sidebar tab
Click on the ‘Sidebar’ tab at the 
top of the Finder Preferences 
window and then tick the items 
that you would like to see 
displayed in the sidebar.

3 Open a window
Now, when you open a new 
window in Finder, your specified 
items will be listed down the left-
hand side of the window for easy 
access when you need them.

The place to 
come for key 
terms made easy 
to understand 

Glossary

Facebook
iCreateMagazine

Twitter
@iCreateMagazine

Web
www.gadgetdaily.xyz

Email
icreate@futurenet.com
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1 Click on the ‘!’
While in Chrome, click on the ‘!’ 
icon in the top-right corner and 
then select More Tools>Task 
Manager from the menu.

2 Click on ‘Memory’
In the Task Master, click on the 
‘Memory’ tab and you can see 
which sites and extensions use up 
the most memory.

3 Close tabs
You can now close the tabs of the 
sites that take up the most battery-
sapping memory. You can still visit 
them, just don’t leave them open.

I use Google Chrome as my main browser but it drains my 
MacBook battery very quickly, why? Sam Griffiths

Sometimes, when I import a CD into iTunes the artwork  
doesn’t display in my library, can I fix this? Lyn Hughes

The one-stop 
column for  
Genius advice
Do I need any special 
software or cables to 
connect my MacBook 
up to an external 
monitor? I have seen 
people at work do this 
and their Macbooks 
remain closed.
This is called ‘clamshell’ 
mode. To use it, connect 
your Mac to the external 
monitor by whatever 
means you want (HDMI, 
Mini Display Port, 
Thunderbolt, DVI, Mini-
DVI or Micro-DVI) and 
ensure that you also have 
an external keyboard 
and mouse and that the 
MacBook is connected to 
a power source. If you are 
using a wired keyboard 
and mouse, make sure 
they are connected and 
then simply close the lid 
of your MacBook. Your 
desktop should then 
automatically appear on 
the monitor. If you are 
using a Bluetooth external 
keyboard and mouse then 
make sure that they are 
paired correctly with the 
MacBook and then go 
to System Preferences> 
Bluetooth>Advanced and 
then make sure that the 
‘Allow Bluetooth devices 
to wake this computer’ 
option is ticked. To exit 
out of clamshell mode, 
simply put your MacBook 
to sleep and then 
disconnect the external 
monitor from your Mac’s 
display port and take it 
away. Easy!

Apple 
Expert

I have quite sensitive hearing and 
have heard that there is a way to 

adjust the volume on my Mac in smaller 
increments. How do I do this? Steve West
All you have to do is press and hold Shift+Alt 
and then tap the volume up or down buttons 
on your Mac keyboard. You should now notice 
that rather than going up or down one square 
at a time, the volume will increase or decrease 
in 0.25 increments, making it much easier to 
obtain the exact volume that you want when 
using your Mac.

Remember, if your listening to music through iTunes then that has its own 
volume controls independent to those of your Mac.

 Get info
Right-click on the album and 
choose the ‘Get Info’ option from 
the menu that appears. Then 
click on the ‘Edit Items’ option.

 Number of discs
Also check that the ‘Compilation’ box is unticked as this 
can confuse matters. To merge multiple CDs into one 
iTunes library entry (if it is a double album), remove any 
‘[Disc 1]’, ‘[Disc 2]’ text after the name of the album.

 Manually add art
If all else fails, simply source 
the artwork for the album 
yourself on the internet, 
click on the ‘Artwork’ tab 
and then drag the artwork 
into it to apply it to your 
album in iTunes.

Hold Shift+Alt 
to make fine 
adjustments to your 
Mac’s volume…

 Check info
Sometimes, the Artist can be labelled as 
‘Various’, even if the album is released by 
one artist in particular. If you see this, simply 
change this entry to the correct artist name, 
then click ‘OK’. Right-click again and choose 
‘Get Album Artwork’ to see if it has worked.
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The one-stop 
column for  
Genius advice
The red number next 
to the Mail icon on my 
iPhone screen tells me 
that I have 3,892 unread 
messages. Is there any 
way to stop this number 
from appearing? 
Not unless you read 
your unread messages 
and then stay on top of 
your incoming emails. 
Open Mail, select ‘All 
Inboxes’ or the name of 
the account you are using 
and then tap the ‘Edit’ 
option in the top-right 
corner. Now tap the ‘Mark 
All’ option in the lower-left 
corner and choose ‘Mark 
as Read’. The number 
should then vanish within 
a few seconds, until you 
get new mail.

Is there any way to 
reduce the brightness 
of the Control Centre 
flashlight my iPhone?
That depends on what 
model of iPhone you 
have. If you have an 
iPhone 6s, 6s Plus, 
iPhone 7 or 7 Plus then 
you can force press on 
the flashlight icon within 
Control Centre and adjust 
the brightness setting. If 
you have an older iPhone 
then we’re afraid that 
you’re out of luck.

How do I restore default 
iPhone apps that I have 
deleted off my device?
Just go to the App Store, 
search for them and then 
tap on the iCloud icon.

Apple 
Expert

Is there any way to increase the size of the road numbers in 
the Mac Maps app? My eyesight is quite bad and I struggle 

to make them out when plotting routes. Robert Castle
There is indeed. While in the Maps app on your Mac, simply click on 
the ‘View’ menu bar item and then go to Labels>Use Large Labels. 
This will instantly increase the size of the labels displayed on the map, 
making them much easier to read. These labels then stay the same size 
regardless of how much you zoom in. If you want to disable the large 
labels and revert back to the normal sized ones then simply repeat the 

process. You 
will also find 
plenty of other 
useful options 
within the View 
menu, such as 
the option to 
‘Show Traffic’.

How do I control what 
features are accessible 

on my iPhone when it is 
locked. Can I turn off the 
widgets, for example?  
Chris Cole
Yes you can. Just go to 
Settings>Touch ID & Passcode, 
enter your passcode (or turn it 
on, if you haven’t already) and 
then scroll down to the section 
marked ‘Allow Access When 
Locked’. You will need see a 
whole list of features that you 
can toggle on or off to make 
them accessible from your Lock 
screen or remove them. These 
include Today View (which is 
effectively the widgets), Siri, 
Notifications View, Wallet and 
more. You have the power to 
determine what gets seen on 
your Lock screen.

Make those road 
numbers easier to 
read in the Mac 
Maps app

How do I know when there are updates available for  
iBooks purchases? Will it notify me? Simon Mumford

 Check ‘Purchased’
Tap on the ‘Purchased’ tab 
and then tap on the ‘Updates’ 
option that is listed under ‘My 
Purchases’ to display the books 
that have updates available.

 Fresh updates
Books that you have 
previously purchased that 
have updates available will be 
listed on the Updates screen.

 Update your book
When the ‘Update’ icon is 
displayed next to a book, 
simply tap on it and your 
book will be updated quickly 
and easily.

 Red circle
When you open iBooks, if there 
are updates available for your 
books then a red number will be 
displayed here.

Genius Bar
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The number of instruments in the iOS GarageBand 
app is puny compared to Mac, why? Ryan Cresswell

How do I add a signature digitally to PDF documents on my iMac?  
It seems to be different every time I write it! Mark Rogers

1 Launch Preview
Start off by launching your Preview app and 
then click on the Tools menu bar item and go 
to Annotate>Signature>Manage Signatures.

2 Sign and scan
Now write your signature in dark ink on white 
paper, hold it up to your Mac’s camera and 
wait for it to scan. When it does, click ‘Done’.

3 Scale into place
When you need to sign a PDF, go to Tools> 
Annotate>Signature, choose the one you just 
made and then scale it down to fit the doc.

I have recently purchased a pair of AirPods but I 
am very nervous about losing them. Is there any 

way to keep tabs on them? Ian Carter
There certainly is. Open up the Find My iPhone app and 
then wait for a few seconds while it looks for your devices. 
If the AirPods are within Bluetooth range then it will locate 

them. If your AirPods appear at the 
top of your list of devices then their 
location will be shown on the map 
immediately. After selecting them, 
you will see an option at the bottom 
of the screen called ‘Actions’. Tap 
on this and select the ‘Play Sound’ 
option to make the AirPods emit a 
sound that gets steadily louder.

Use the Find My iPhone app to 
pinpoint your lost AirPods

My iPhone 5S has recently started disconnecting 
from the home Wi-Fi when it is locked. This is 

very annoying, so how can I fix it? Kevin Hill
To start with, go to Settings>General>Software Update 
and then make sure that you have updated to the most 
recent version of the iOS (there will be no software updates 

available if you have). If the problem 
still persists after updating, try going 
to Settings>General>Reset and 
then choose the ‘Reset Network 
Settings’ option. By selecting this 
option all of your phone data will 
be kept intact but your wireless 
connections will revert back to their 
default settings. Now log into your 
wireless router again and it should 
solve the problem

Resetting your network settings  
should solve connection issues…

 Instrument option
When recording live instruments, you will 
be able to adjust various settings to fit 
your recording environment for the best 
possible sound.

 Extra effects
Some instrument categories have more 
additional sound effects than others. The 
Audio Recorder, for example, is packed 
full of them…

 Record live
You can use the Audio Recorder 
instrument to tape any live sound, 
including your own singing or additional 
instruments straight into the app.

 More Sounds
There are many more sounds available 
for the numerous instruments. As you 
scroll through, just tap on ‘More Sounds’ 
(if applicable) to access more.

When you create a signature in the Preview app it will be added to the 
toolbar at the top of an open document for easy access.
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Genius Bar

I have heard that there is a way to make my iPhone’s 
screen dimmer than usual to save battery, how? Sal James

1 Go to Settings
Go to Settings>General> 
Accessibility. Now enable the 
‘Zoom’ option and then set 
the ‘Zoom Region’ to ‘Full 
Screen’ in the same menu.

2 Choose filter
Now tap on your screen three 
times using three fingers and 
then tap on ‘Choose Filter’ 
and select ‘Low Light’. Tap 
anywhere with one finger.

3 Triple-tap
In the Accessibility settings, 
tap ‘Accessibility Shortcut’ 
then choose ‘Zoom’. You 
can now triple-tap the Home 
button to dim your screen.

I have recently started using WhatsApp as my main text 
messaging app and wondered if there was a quick and 
easy way to delete messages? Stuart Jones

One of the things I liked about my 
old phone was that it used to flash 

when there were new messages and 
missed calls. Is there a way to make an 
iPhone do this? Michael Green
Yes, the feature is called ‘LED Flash for 
Alerts’ and it can be enabled by going to 
Settings>General>Accessibility. Now scroll 
down to the Hearing section and you will see 
this option. Tap on it and then turn on the 
‘LED Flash for Alerts’ option. You can also 
command your iPhone to ‘Flash on Silent’, 
which is useful if you are expecting important 
calls or messages but circumstances dictate 
that you have to keep your iPhone’s volume 
muted, such as an important meeting.

What is the quickest way to save a 
story in the iPhone News app? 

Unfortunately, I usually find something 
interesting to read just as I am about to 
get off the train! Jonathan Stokes
The quickest and easiest way to save stories 
to read later is to swipe to the left across the 
headline of the story. Doing so will present 
three options – Love, Share and Save. Just 
tap the ‘Save’ option and the story will be 
saved for later. To access it, simply tap on 
the ‘Saved’ option in the lower-right corner 
of the interface and all of your saved stories 
will be listed in chronological order. Once 
you have read them, swipe left and choose 
the ‘Don’t Save’ option.

 Mute chat
You can also choose to 
‘Mute’ chats, which mean 
you won’t be privy to the 
messages within for an 
amount of time that you 
specify (eight hours, one 
week or one year).

 Group info
If you choose the 
‘Group Info’ option 
then you can adjust 
various options. For 
example you can set a 
custom alert tone for 
that particular group, 
opt to save incoming 
media, see who is 
currently connected to 
the group and exit the 
group, if you want.

 Delete texts 
manually
To delete individual 
or selected strings of 
messages, enter the 
chat room, press and 
hold on a message 
then tap on the arrow, 
then choose ‘Delete’.

 Clear entire 
conversations
The quickest and easiest 
way of deleting text 
messages is to swipe left 
on the chat room itself 
and then tap ‘More’. A 
list of options will now 
appear from which you 
can select the ‘Clear Chat’ 
option. This will wipe all 
messages within.

You can turn on LED Flash for Alerts by 
going to the Accessibility settings…
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The one-stop 
column for  
Genius advice
What with the recent 
delay in rolling out iOS 
10.3 to my model of 
iPhone, I am worried 
that iOS 11 won’t work 
on my iPhone 5C at all. 
Do you have any news 
on this ?
Yes, and we’re afraid it’s 
not good. Unfortunately, 
iOS 11 will only run 
on the iPhone 5S and 
above. What’s more, 
all 32-bit apps will also 
become obsolete. So 
unless updates become 
available, you may have 
to ditch some of your old 
favourites in time.

I have heard that there 
is a way to hide certain 
options in System 
Preferences on my Mac, 
how is this done?
Open System 
Preferences, and then 
click and hold on the 
grid icon on the top bar. 
This should list all of 
your preferences. Scroll 
down the list and select 
‘Customize’ then you 
can tick and untick to 
determine what is shown.

How can I stop my Mac 
automatically updating 
my apps?
Go to System 
Preferences>App Store 
(or when in the App Store 
click on App Store> 
Preferences) and then 
untick the boxes relating 
to automatic downloads 
and installation.

Apple 
Expert

Remember that you can press and hold on various keys to access 
punctuation and accents. Hold, slide to it and then release.

I remember hearing that you could start typing on your iPad 
keyboard and then pull the on screen keyboard apart to have 
half on either side of the screen. Is this still possible? Paul Fletcher

1 Press and hold
You can no longer physically part 
your keyboard manually using 
your fingers. Instead press and 
hold on the keyboard icon.

4 Secret keys
If you tap on the space next to 
the keys on the left, you will type 
the letter of the first keys on the 
right, and vice versa.

2 Opt to ‘Split’
This will bring up two options, 
Undock and Split. Tap on the ‘Split’ 
option and the keyboard will be 
undocked and split in half.

5 Revert to old
You can opt to Merge or Dock 
and Merge your keyboard by 
pressing and holding on the 
keyboard icon once again.

3 Easier typing
Some find the repositioned 
keyboard easier to use as you 
essentially use your thumbs to do 
all of the typing.

6 Easy editing
If you try placing and parting your 
thumbs on the keyboard you will 
be able to reposition the cursor or 
select parts of the text.
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Group test

Bluetooth 
Speakers

MP233 Portable Speaker 
£42.99/$52.99

edifier.com
Developed with twin 48mm neodymium drivers and a 
passive bass radiator, this pocket rocket is capable of 

belting out the same levels of sound as a speaker twice 
the size. Near Field Communication (NFC) integration 
also allows you to connect your iPhone to the speaker 

simply by being in close proximity. You can also connect 
via Bluetooth 4.0, MicroSD or 3.5mm AUX and the built 

in lithium-ion battery can power the unit for up to 12 
hours. Ideal for use down the beach when you don’t 
want the crashing of waves to drown out the tunes.  

MP211 Portable Speaker 
£33.99/$43.99

edifier.com
Ideal for beach parties and festivals, this compact 
speaker has plenty of connectivity in the form of 

Bluetooth 4.0, an SD Card port and a 3.5mm AUX input 
socket. It also comes with a built in microphone so that 

you can make and answer calls through the speaker. 
The total power output is 2 x 2W, so it isn’t ever likely 
to disturb the sheep in the next field, but the quality of 

sound it produces is pretty well balanced for a small unit. 
Available in five colours, the size and weight (0.215kg) of 
the MP211 means it can be stowed easily in rucksacks. 
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MP700 Boom Box  
£199.99/$187.99

edifier.com
Bigger and, indeed, ‘boomier’ than the other portable 

speakers featured here, the MP700 features a built-in Digital 
Signal Processing (DSP) and Dynamic Range Control (DRC) 
to kick out 36 watts of high-quality sound. Contained within 

the unit are two drivers and two silk dome tweeters that 
provide crisp, balanced sound, although it holds back on the 
bass a little too much for our linking. The stylish, mesh finish 
of the MP700 is supported by a sturdy aluminium handle for 
easy grab-and-go transportation and it uses Bluetooth 4.0 or 

NFC to connect up to your iPhone. 

MP280 Speaker 
£79.99/$79.99

edifier.com
The cylindrical design of this portable speaker uses 

the reflective cone structure to produce full 360 degree 
sound that will impress the hell out of everyone at your 

party. Available in blue, red or black, the MP280 features 
Bluetooth 4.0 connectivity from your iPhone and is also 

microSD and AUX compatible. What’s more, if your 
iPhone is running dangerously low on power then you can 
even use it as an emergency charger. Though it is facing 
serious competition from Denon’s new Envaya Bluetooth 

speaker range, this still comes highly recommended. 
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The Touring/S looks great, is finely crafted to the highest standards  
and kicks out some serious sounds whatever you choose to listen to.  

It’s audio clarity comes at a cost though – the bass.

Geneva Touring/S  
portable speaker  

£170/$210

Verdict

Key features
FM/DAB/DAB+ • Bluetooth • 20 hours of audio playback

Learn more
genevalab.com

Available from
amazon.co.uk

Doubling up as an FM/DAB radio and a Bluetooth 
speaker, Geneva’s Touring/S is a high quality sound 
system sitting in a small, somewhat retro looking 
box. Inspired by iconic portable radios of the past, 
the Touring/S is precision-engineered from high-
quality aluminium and everything, from the buttons 
on the top to the rubber base suggests ‘premium 
product’. The On/Off/Volume dial has a super-smooth 
action and the LED display on the side sparks into 
life immediately. If you are using the device as an FM 
radio then you can pull up the aerial on the top and 
then use the arrow buttons to tune in to a station. Hit 
the DAB button though and the device will instantly 
start scanning for stations and begin broadcasting 
them with crystal clarity. Finally, you can press the 
Bluetooth button to make the Touring/S discoverable 

to your iPhone and then start beaming your own 
music to it, which is when it really comes alive.

The neodymium speaker drivers within the unit 
provide and exceptionally wide frequency range and 
low distortion, delivering rich and powerful sound. 
For such a small unit, the Touring/S has certainly got 
some bite to it, delivering a quality of tone and sharp 
vocals that similarly-sized units just cant compete 
with. The rechargeable battery provides up to 20 
hours of audio playback and the size and weight 
dimensions mean you can effortless pick up and 
place the Touring/S anywhere.

Available in red, white, black or cognac, the 
Touring/S is a luxury item that delivers in all 
departments except boom of bass – but that would 
probably cause your Pimms glass to topple over.

The LED display constantly scrolls along 
the window to inform you of what radio 
station you’re listening to

There are buttons to select presets, 
browse channels, switch between FM/
DAB and activate a Bluetooth

Small ports on the rear of the device 
allow you to charge up the battery and 
connect via 3.5mm AUX
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Nice looking, exceptionally comfortable  
to wear and capable of delivering incredible 
clarity of sound. Highly recommended.

Denon AH-C821
 Earphones 

£169.99/$189.99

Verdict

Key features
Double Air Compression Driver with dual cable • Comply ear tips

Learn more
denon.com

Available from
amazon.co.uk

It’s a screaming testament to the quality of these 
earphones that put them in and you’ll want to kick 
back and listen to your entire music collection as 
it all sounds cleaner and clearer than before. 
This is largely thanks to Denon’s patented 
Double Air Compression Driver which uses 
two 11.5mm drivers, one in front of the 
other, to deliver powerful, low-distortion 
bass and amazing clarity. This design also 
uses separate wires from the plug to each 
driver for the ultimate signal purity.

The drivers themselves are mounted in 
die-cast aluminium and resin casings that are 
designed for rigidity and vibration-damping, 
while dual Denon Acoustic Optimiser ports 
to the front and rear of the casings help to 
equalise the air pressure to the front and 
rear of the drivers. The result is premium-
sounding audio and actually breathes new life 
into your music. Also included in the box are 
Comply Tx-500 ear tips, which combine with 
the ergonomically-shaped casings to provide 
a secure fit for the purest sound and optimum 
outside noise isolation. These tips actually use 
memory foam activated by the heat from the 
user’s ear to perfectly mould themselves to the 
listener. There is also a selection of silicon ear tips 
included along with a carry case and cable clip.

Make no mistake, the AH-C821 earphones 
sound exceptional, but if you wish to tailor the 
sound that they produce further to better suit 
your tastes then you can do so via the Denon 
Audio app (which is free to download from the 
App Store). Not only does this app help you 
optimise the sound of your portable devices, it 
also provides an alternative interface for listening 
to your music and a gateway to over 70,000 
online radio stations – the ideal showcase for 
what these pocket rockets have to offer.

The ear tips are fashioned out of memory 
foam that reacts to the heat from your 
ears to form the perfect fit

Included in the box is a neat carry case 
that keeps the cables safely wound up 
while not in use…

A selection of silicon ear tips are also 
included so that you can obtain the 
optimum comfort for your ears
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While it won’t blow you away as a portable 
speaker, the S3 certainly has plenty going for it 
in terms of functionality and price.

S3 Wireless Bluetooth 
Speaker & Alarm Clock 

£40/$40

Verdict

Key features
Built-in phone charging port • Bluetooth 4.0 • Dual speaker

Learn more
mixx-audio.com

Available from
amazon.co.uk

New from Mixx Audio, the S3 Wireless Bluetooth 
Speaker & Digital Alarm Clock combines a decent 
sound with plenty of functionality, whether it’s used 
as a wireless bedside speaker, a digital alarm clock 
or as a phone charger. Available in pink or black, this 
lightweight device also features an anti-slip base to 
reduce surface vibration and a dual speaker design 
for bass and detail.

The S3 uses Bluetooth 4.0 to easily connect to 
any audio device, including your iPhone, iPad or 
Mac within a 30ft/10 metre radius and features a 
rechargeable battery which can support up to seven 
hours of continuous music playback. As a portable 
speaker, it sounds nice and clear, but lacks any sort 
of bass drone, rendering some of your music a little 
tinny. Of course, if you are primarily using it as a 
portable speaker then there is also no getting away 
from the fact that it looks like an alarm clock thanks 
to the digital readout on the front and therefore may 
look odd placed anywhere but next to your bed. 

Unsurprisingly then the S3 works far better as a 
digital alarm clock. The built-in charging port means 
that you can power up your iPhone overnight and 
then wake up to your favourite tunes beamed straight 
to the device via Bluetooth 4.0. The unit also comes 
with a built-in microphone that allows for hands-
free calls. The 24-hour digital clock display is nice 
and clear and setting an alarm is a quick and easy 
process. And when the alarm does sound, you can 
grab a few extra minutes of slumber by touching 
the device to initiate snooze mode. There is also the 
option for an additional backup battery option (2xAA) 
to retain the clock time and alarm and, if you intend to 
connect other devices to it via non-Bluetooth means, 
you’ll be glad to know that it also offers a 3.5mm  
Aux port option.

The unit features USB and micro USB 
ports so you can use it to charge up your 
iPhone overnight

The S3 features a 24-hour digital clock 
complete with dual alarm and snooze 
for grabbing a few extra minutes…

Available in pink or black, the S3 
features two internal 3W speakers, one 
for bass and one for vocals and detail
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Accessories

Pom Pom 
Powerbank

£15.95/$19.95
prezzybox.com

Resembling a freshly multiplied 
Mogwai, this portable powerbank clips 
easily onto keys, bags or backpacks 

to provide a welcome charge of power 
for your iOS device while out and about 

this summer. The fluffball features 
protruding USB in and out sockets 

for you to charge it up before heading 
out and to plug other devices into it 

on your travels to stay topped up with 
power. It provides one full charge for 
an iPhone and can stay charged up 

for days on end in case of emergency.

R19U Speakers
£19.99/$29.99
edifier.co.uk

If you’re on the hunt for a decent 
sound on a very strict budget then 
these angled desktop speakers are 
well worthy of consideration. You 

can connect them to your Mac with a 
single USB cable for both power and 
connectivity or use the AUX port to 
plug them into your iOS device and 
they provide a clean sound with no 

distortion unless pushed to the limit. 
Okay, so you know just by looking at 
them that bass (or lack of…) is going 
to be an issue, but for the price they 
certainly impressed the hell out of us. 

Banks 15” Laptop 
Backpack

£99.99/$129.99
stmgoods.com

Featuring SlingTech protection that 
not only provides padding to your 

Mac laptop but suspends it above and 
away from the edges of the pack, thus 

keeping it isolated from the impact 
zone, this premium backpack is stuffed 

full of innovation. It also features the 
CableReady cable-routing system 
that keeps charging cables stowed 
out of the way, a ‘Stash’ detachable 
case for smaller items and enough 

pockets to pack other essentials away 
in and probably forget about forever.
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Solace LX iPhone 7 Case
£24.99/$99.95

elementcase.com

You know you just purchased a serious iPhone case 
when it comes with its own wrench tool to help you 
effectively imprison your phone within the shell. The 

Solace LX comes with a soft-touch coated body, 
genuine leather backing and a pair of hand-polished 

aluminium crowns that you can detach with the 
aforementioned tool to fix your device snugly into 
place. It’s a lovely product that is lightweight and 
very durable with a shock-absorbing liner that will 

cradle your iPhone 7 through any hard knocks.

Fishhook Laptop Stand
£19.99/$29.99
fishhook.se

There are two main advantages with using this 
stand to prop up your laptop. For starters, its 

ergonomic design forces you to sit up straight when 
using it, and second, the free ventilation underneath 

means that your computer won’t overheat. It also 
features two different sizes of hooks to fit all types 
of laptop and two different height settings for you 

to find your optimum typing position. We have been 
using this all month and can highly recommend it 

for eliminating slouching while working.



iMac G3 
Bondai Blue

Release date

May 6, 1998
 

• 233MHz Power PC 750 G3 processor 
 • 512k backside level 2 cache • 32MB RAM 
• 4GB EIDE hard drive • Either ATI Rage IIc 
graphics with 2MB of VRAM or ATI Rage 
Pro Turbo graphics with 6MB of VRAM

Original price
£1,299/$1,299

Price now
£89/$99

When Steve Jobs returned to Apple 
as CEO after the merger with his 
company, NeXT, in 1997, he set 

about reviving the flagging company 
and chose a design that British 
industrial designer Jonathan Ive 
was working on to develop as a 

prototype for a new Apple product. 
The result as the iMac G3 Bondai 

Blue, which effectively saved Apple 
from going bankrupt. Among the 

computer’s innovative features was 
the incorporation of a digital media 
drive and an internal modem. It also 

ditched the 3.5-inch floppy drive, 
replacing it with facilities to connect 
external drives via USB. Above all 
else though, it was the distinctive 

colour and design that really 
captured the public’s imagination.
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